Gsas

SAS® OnDemand

for Academics
Usage Guide for Instructors

SAS® Documentation




The correct bibliographic citation for this manual is as follows: SAS Institute Inc. 2011. S4S"
OnDemand for Academnics: Usage Guide for Instructors. Cary, NC: SAS Institute Inc.

SAS" OnDemand for Academics: Usage Guide for Instructors
Copyright © 2011, SAS Institute Inc., Cary, NC, USA
All rights reserved. Produced in the United States of America.

For a hard-copy book: No part of this publication may be reproduced, stored in a retrieval system, or
transmitted, in any form or by any means, electronic, mechanical, photocopying, or otherwise, without
the prior written permission of the publisher, SAS Institute Inc.

For a Web download or e-book: Your use of this publication shall be governed by the terms
established by the vendor at the time you acquire this publication.

The scanning, uploading, and distribution of this book via the Internet or any other means without the
permission of the publisher is illegal and punishable by law. Please purchase only authorized electronic
editions and do not participate in or encourage electronic piracy of copyrighted materials. Your support
of others’ rights is appreciated.

U.S. Government Restricted Rights Notice: Use, duplication, or disclosure of this software and related
documentation by the U.S. government is subject to the Agreement with SAS Institute and the
restrictions set forth in FAR 52.227-19, Commercial Computer Software-Restricted Rights (June 1987).

SAS Institute Inc., SAS Campus Drive, Cary, North Carolina 27513.
Ist electronic book, September 2011

SAS” Publishing provides a complete selection of books and electronic products to help customers use
SAS software to its fullest potential. For more information about our e-books, e-learning products, CDs,
and hard-copy books, visit the SAS Publishing Web site at support.sas.com/publishing or call 1-800-
727-3228.

SAS”and all other SAS Institute Inc. product or service names are registered trademarks or trademarks
of SAS Institute Inc. in the USA and other countries. ® indicates USA registration.

Other brand and product names are registered trademarks or trademarks of their respective companies.



Contents

Chapter 1 Introduction to SAS OnDemand for Academics |l
Introduction

Client Software

Server Software - SAS Enterprise Guide

Server Software - SAS Enterprise Miner [

Server Software - SAS Forecast Server (Beta)

Chapter 2 SAS OnDemand for Academics: Enterprise Guide J
SAS OnDemand for Academics: Enterprise Guide B

Step 1. Confirm system requirements B

Confirm requirements for full support E

Verify network performance @

Step 2. Set up your SAS OnDemand for Academics account §
About the SAS OnDemand for Academics Control Center §
About your SAS Profile account §

Important information before you begin B

Register as an instructor E

Register a course [

Step 3. Access and use the software

Access your SAS OnDemand for Academics account

Install SAS Enterprise Guide

About Software Order E-mails [L0

Access the SAS Server [10

Avoid connection time-outs [L1]

SAS Server maintenance and availability

Requesting SAS Server availability notification [1]

Step 4. Prepare course data

Options for providing course data to students @

Requesting assistance with custom course data on the SAS Server
Requirements for storing custom course data on the SAS Server @
Uploading course files to the SAS Server @

Accessing course files stored on the SAS Server [L7

Step 5. Review and test Course Materials

Importance of reviewing the software [19

Teaching materials provided by SAS [19

Practice exercises, statistics information, and sample SAS data sets
Books, training, and other reference materials @

Step 6. Share course information with students R(

Ask students to register for SAS OnDemand for Academics R(



iv Contents

Provide students with information about the system R1|

Suggested information to share with students El]

Step 7. Review the basics for working with data and results @

Working with data P2

Working with Results 27

Step 8. Finding Help for Common Problems R§

Where can instructors find help? R§

Where can students find help R9

Commonly Asked Questions: SAS OnDemand for Academics: Enterprise Guide R9

Chapter 3 SAS OnDemand for Academics: Enterprise Miner
SAS OnDemand for Academics: Enterprise Miner

Step 1. Confirm system requirements B8

Confirm requirements for full support

Verify network performance BY

Verify and install a Java Runtime Environment (JRE) B9

Step 2. Set up your SAS OnDemand for Academics account @
About the SAS OnDemand for Academics Control Center 41

About your SAS Profile account 9

Important information before you begin 42

Register as an instructor 42

Register a course 43

Step 3. Access and use the software 43

Access your SAS OnDemand for Academics account 43

Access SAS Enterprise Miner {44

Access the SAS Server §5

SAS Server maintenance and availability 45

Requesting SAS Server availability notification [#5

Step 4. Prepare course data 45

Options for providing course data to students 46

Requesting assistance with custom course data on the SAS Server §7
Requirements for storing custom course data on the SAS Server @
Uploading course files to the SAS Server 4§

Accessing uploaded course data on the SAS Server @

Step 5. Review and test course materials 53

Importance of reviewing the software B3

Teaching materials provided by SAS 53

Accessing teaching material and data for SAS Enterprise Miner @
Practice exercises, statistics information, and sample SAS data sets @
Books, training, and other reference materials B4

Step 6. Share course information with students 55

Ask students to register for SAS OnDemand for Academics 55
Provide students with information about the system [F6



Contents

Suggested information to share with students p6

Step 7. Review the basics for working with data, results, and projects B6
Working with data 56

Working with projects 58

Sharing homework assignments (]

Step 8. Finding Help for Common Problems 62

Where can instructors find help? [63

Where can students find help 63

Commonly Asked Questions: SAS OnDemand for Academics: Enterprise Miner 64
Chapter 4 SAS OnDemand for Academics: Forecast Server (beta)
SAS OnDemand for Academics: Forecast Server (beta) [70

Step 1. Confirm system requirements [70

Confirm requirements for full support. [70

Verify network performance [7]

Verify and install a Java Runtime Environment (JRE) [7]

Step 2. Set up your SAS® OnDemand for Academics account @

About the SAS OnDemand for Academics Control Center [73

About your SAS Profile account [73

Important information before you begin [74

About SAS Forecast Server environments [74

Register as an instructor [74

Register a course [75

Step 3. Access and use the software [75

Access your SAS OnDemand for Academics account [75

Locate the name of your SAS Forecast Server environment [75

Access SAS Forecast Server [76

Access the SAS Server [76

SAS Server maintenance and availability [77

Requesting SAS Server availability notification [77

Step 4. Prepare course data [77

Step 5. Review and test Course Materials [77

Importance of reviewing course materials [7§

Teaching materials provided by SAS [7§

Books, training, and other reference materials [7§

Step 6. Share course information with students [7§

Ask students to register for SAS OnDemand for Academics [19

Provide students with information about the system B0
Suggested information to share with students B0

Step 7. Review the basics for working with data and results B0
About project storage 80

Working with forecasting project results 80
Step 8. Help for Common Problems @

v



vi Contents

Where can instructors find help? [1|
Where can students find help B9
Commonly Asked Questions for SAS OnDemand for Academics: Forecast Server B9

Appendix 1 Commonly Asked Questions for SAS OnDemand for Academics B5
Commonly Asked Questions for SAS OnDemand for Academics B85

General/Cost/License B5

Availability and Installation 86

General Usage B17

General Support B9

Appendix 2 Learning Resources for SAS OnDemand for Academics 93
Learning Resources for SAS OnDemand for Academics 93

Training and Usage Videos D3

e-Learning Courses 94

Teaching materials 94

Enterprise Guide resources 94

Tutorial 94

Online SAS Enterprise Guide Demonstration 95

Online Practice Exercises, Statistics Information, and Sample SAS Data Sets P5
Product Documentation Pj

Books 9§

White Papers 9§

Enterprise Miner resources 96

Product Documentation 96

Books P6

Forecast Server resources 96

Product Documentation 96

Books P6

Appendix 3 SAS OnDemand for Academics with JMP Software 97
SAS OnDemand for Academics with JMP Software 97

Step One: Registering to use SAS OnDemand for Academics 97
Instructor registration 97

Student registration 98

Step Two: Downloading and installing the sas.rutil jar file 9§

Step Three: Creating a SAS Server Profile within JMP

Step Four: Connecting to the SAS Server using JMP @



CHAPTER

Introduction to SAS OnDemand for
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Introduction

SAS OnDemand for Academics provides an online delivery model for teaching and
learning data management and analytics. By connecting to a SAS-hosted server over the
Web, users access the analytical power of SAS software through a user-friendly, point-
and-click interface.

The advantages of using SAS OnDemand for Academics include:

O Students and professors gain immediate online access to SAS software — with no
configuration or support concerns.

O Students, including both onsite and distance learners, can use SAS whenever or
wherever they please - no more waiting for a seat in a campus computer lab or
having to buy and install software.

O SAS allows professors to teach data management and analytics, providing
multiple software applications without maintenance or IT overhead.

O SAS has been used in colleges and universities for more than 30 years.

O With quick access to award-winning software for data management and analytics,
students gain valuable SAS skills that are highly sought after in the job market.

The following sections list the SAS software available with SAS OnDemand for
Academics.

Client Software

Instructors can choose to use one of the following software applications when they
register a course with SAS OnDemand for Academics:

O SAS Enterprise Guide
O SAS Enterprise Miner
O SAS Forecast Server (Beta)

When students register for the course, they must select the same software application
that their instructor has chosen to use.
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Server Software - SAS Enterprise Guide

The following products are available on the hosted SAS server that supports SAS
OnDemand for Academics: Enterprise Guide:

Sy Iy S I [y

Base SAS

SAS/STAT software

SAS/GRAPH software

SAS/ETS software

SAS/OR software, including OPT, PRS, IVS, and LSO
SAS/IML software

SAS/CONNECT software

SAS High-Performance Forecasting

SAS/ACCESS Interface to PC Files

Server Software - SAS Enterprise Miner

The following products are available on the hosted SAS server that supports SAS
OnDemand for Academics: Enterprise Miner:

| Sy Iy Ay oy S [

Base SAS

SAS/STAT software

SAS/GRAPH?® software

SAS/ETS software

SAS/OR software, including OPT, PRS, IVS, and LSO
SAS/IML software

SAS/CONNECT software

SAS Enterprise Miner

SAS Credit Scoring

SAS Text Miner

SAS High-Performance Forecasting
SAS/ACCESS Interface to PC Files

Server Software - SAS Forecast Server (Beta)

The following products are available on the hosted SAS server that supports SAS
OnDemand for Academics: Forecast Server:

| Sy )y Sy S [y

Base SAS

SAS/STAT software

SAS/GRAPH software

SAS/ETS software

SAS/OR software, including OPT, PRS, IVS, and LSO
SAS/IML software

SAS/CONNECT software

SAS Enterprise Miner

SAS Credit Scoring
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SAS Text Miner

SAS High-Performance Forecasting
SAS/ACCESS Interface to PC Files
SAS/ACCESS Interface to MYSQL

SAS Forecast Studio

SAS/IML Studio

Server Software - SAS Forecast Server (Beta)

3
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SAS OnDemand for Academics: Enterprise Guide

This manual guides instructors through recommended steps for registering for SAS
OnDemand for Academics, preparing to teach courses, and supporting students while
using SAS software.

Step 1. Confirm system requirements

Check these guidelines to ensure your students can access the software.

Confirm requirements for full support

Instructor and student systems must meet these requirements for SAS OnDemand for
Academics: Enterprise Guide to be fully supported.

Supported/Required Notes
Operating Microsoft Windows 7 Home  Macintosh operating systems are not
systems Premium and above (32-bit  supported
or 64 bit)
Microsoft Windows Vista Other versions of Microsoft Windows
Home Premium (32-bit or 64 Vista might work but have not been
bit) fully tested and, therefore, are not

supported by SAS.

Microsoft Windows XP If missing, Microsoft .NET Framework

Professional version 3.5 Service Pack 1 will be
installed for users of Microsoft
Windows XP Professional. Depending
on the files required, installation could
take from5 to 90 minutes.




SAS OnDemand for Academics: Enterprise Guide  Step 1. Confirm system requirements 7

Supported/Required Notes
Internet Microsoft Internet Explorer  Other internet browsers might work
browser 8 or earlier but have not been fully tested and are

thus not supported by SAS.

Hard disk Approximately 80 MB of You will be prompted to install
space free hard disk space Microsoft .NET if it is not on your
machine. This will require additional
disk space.
Internet A high speed connection is Your usage experience depends on the
connection required, which could be speed and reliability of your connection.
broadband (cable), DSL A slower or unreliable connection can
(phone), or wireless result in slow processing or dropped
connections. connections. Be aware that different

wireless connections can provide
different rates of speed and reliability.
See Verify Network Performance for
more information.

Verify network performance

If you plan to teach in a lab or a seminar setting in which many students will access and
use SAS OnDemand for Academics software applications at the same time, then you
should verify the performance of the network that you plan to use (Internet bandwidth,
wireless router capacity, and so on).

If the network performance is not sufficient, then your students could experience slow or
dropped connections to the hosted SAS Servers that are used to perform SAS processing.

You can contact the appropriate network or IT department personnel to request
additional information. Share the following information with them to ensure they gather
accurate data:

O Type of network connection you plan to use (Wireless, LAN, or other) In
particular, wireless networks can be problematic as there are sometimes stricter
limits to the capacity of concurrent users that they can support.

O Number of students that will use SAS OnDemand for Academics concurrently
O Location of the lab or seminar

O Location of the hosted SAS Servers (the answer is: Cary, North Carolina at
SAS Institute)

There are also a number of tools available through the Internet that you or the
appropriate network personnel can use to check network performance. SAS also offers a
tool that might help. To access this tool, perform the following steps:

1 Go to the following Web site: http:/netcheck.sas.com/ookla.
2 Select Begin Test.

Note: If you are not teaching in a lab or seminar setting, then each student must
connect to the hosted SAS Servers to perform processing using their own high-speed
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Internet connection. If individual students have network connection issues, they can try
to use a computer on a different network or contact their Internet Service Provider.

Step 2. Set up your SAS OnDemand for Academics account

As an instructor, there are several important steps you must follow to set up a SAS
OnDemand for Academics account, such as creating a SAS profile and registering
yourself and your course. The online process uses a series of windows to guide you.

About the SAS OnDemand for Academics Gontrol Center

Your starting point for accessing SAS OnDemand for Academics is the SAS OnDemand
for Academics Control Center Web site:
(http://support.sas.com/ctx3/sodareg/index.html)

As an instructor you will use the Control Center to register your account, create courses,
view course information, edit course information, and delete courses. Your students will
use it to register, acquire a license, and view course information.

Your SAS OnDemand for Academics Home Page is created during the registration
process and is part of the SAS OnDemand for Academics Control Center. You will be
taken to your Instructor Home Page once you have set up an account. You access your
home page to register, view, or edit information associated with courses.

About your SAS Profile account

A SAS Profile is an account that you can create to access specific information and
resources from the SAS Web site. If you are a current SAS user, you might already have
a SAS Profile. If you are a new SAS user, a SAS Profile is created for you when you
register for SAS OnDemand for Academics.

An important part of your SAS Profile account is a SAS Profile password that you are
prompted to enter each time you access the SAS OnDemand for Academics Control
Center.

Note: Your SAS Profile password must be changed every 6 months for security
purposes. You will receive an e-mail when your password is approaching expiration. To
reset your SAS profile, visit My SAS Profile page at this location:

https://www.sas.com/profile/user/login.htm

Important information hefore you begin

As you begin setting up your account, it's helpful to keep the following in mind:

O You will need access to your e-mail account. When you begin registration, you will
be prompted to enter an e-mail address. Enter the e-mail address of an account
that you can access easily while completing your registration.

O You will receive an e-mail during the initial registration process that you must
open and act upon to continue. The e-mail prompts you to click a link to verify
your e-mail address. Its primary purpose is to confirm that you are using a valid e-
mail address and that someone else is not attempting to register you without your
knowledge.
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0 If you do not receive the e-mail, please check your junk e-mail folder.

Register as an instructor

Only instructor accounts have the ability to create, edit, or delete courses. If a teaching
assistant is going to act as an instructor, then they must register as an instructor. A
unique e-mail address must be used for the instructor account if the teaching assistant
already has a student account.

There is no cost or obligation associated with registering as an instructor, and following
these steps prepares you to use this offering and provide better guidance for your
students:

1 Go to the SAS OnDemand for Academics Control Center
http://support.sas.com/ctx3/sodareg/index.html

Select New User.
Follow the online prompts to create your SAS profile.

Continue with your registration until you arrive at your Instructor Home Page.

gl B W N

Once on your Home Page, you can then register a course.

Register a course

You must register your course to:
O select and get access to the SAS software that you plan to use
O create course information that you can share with potential students

O create an area where you can store data for the course (should you choose to store
data on SAS Servers).

Note: To avoid confusion and unnecessary support calls, it is important to complete
this step before you invite students to register for SAS OnDemand for Academics When
students register, they must select a university, an instructor, and a course. If you invite
students to register before you have registered a course, they won't be able to select your
course.

1 Go to the SAS OnDemand for Academics Control Center
http://support.sas.com/ctx3/sodareg/index.html

Log on using your e-mail address and your SAS Profile password.
You will arrive at your Instructor Home Page.

Click Register a Course and then follow the instructions.
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Step 3. Access and use the software

By accessing using the software ahead of time, you will be able to anticipate possible
student issues, develop content that might be specific to using SAS OnDemand for
Academics, and have an understanding of how long it should take students to access the
software themselves.

Ideally, you should perform this step before you develop your course outline as SAS
OnDemand for Academics software applications function slightly differently than their
traditional SAS software counterparts. There are a number of resources available to
help you.

Access your SAS OnDemand for Academics account

Your SAS OnDemand for Academics account enables you to view and/or edit information
associated with courses. You will have access to this information after you have initially
registered for SAS OnDemand for Academics.

To access an existing SAS OnDemand for Academics account:

1  Access the SAS OnDemand for Academics Control Center at the following Web
site: http:/support.sas.com/ctx3/sodareg/index.html

2 Enter your e-mail address and your SAS Profile password and then click Enter.

Install SAS Enterprise Guide

To use SAS Enterprise Guide from SAS OnDemand for Academics account, you must
first install a copy of the software on your computer. Follow these steps to install SAS
Enterprise Guide software:

1 Log on to your SAS OnDemand for Academics Control Center using your e-mail
address and your SAS Profile password.

2 Scroll to the bottom of your Home Page to see a table that lists the courses that
you have registered.

3 Click Download Client for the appropriate course.

After the software client is downloaded and installed, you can begin using the
software and accessing the SAS Server.

For step-by-step guidance including graphics, you can download “SAS OnDemand for
Academics: Enterprise Guide Instructor Registration Instructions” from
http://www.sas.com/govedu/edu/programs/enterprise_guide_instructor.pdf or visit the
SAS OnDemand for Academics Web site at http://www.sas.com/academics.

Access the SAS Server

You are prompted to connect to the SAS Server each time you start SAS OnDemand for
Academics: Enterprise Guide. The server (which is hosted at SAS Institute Inc.)
remotely processes any submitted SAS files or projects and returns results to your
computer.

If you are unable to use a SAS OnDemand for Academics software application to
perform processing, make sure that you have a working Internet connection.
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If your Internet connection is working normally, you can check the SAS Server Status
Web page (https:/www.ondemand.sas.com/status/oda/) to determine if appropriate
servers are available or temporarily down for maintenance.

Avoid connection time-outs

Avoid leaving open connections on the server. An open connection to the SAS Server
will likely disconnect (time out) after one hour (or less) if the connection is idle (that is,
you have not performed any processing). Many firewalls disconnect open sessions after
an hour of idle time (or less). SAS recommends that you complete your work, save it, and
then exit SAS OnDemand for Academics: Enterprise Guide before you leave the
computer.

SAS Server maintenance and availability

SAS makes its best efforts to make the server available as much as possible and to keep
unexpected downtime to a minimum. There could be limited times when the server is
unavailable because SAS is performing maintenance, testing, or performance
enhancement tasks.

O Ifserver maintenance is needed, SAS will try to perform this work during
nontraditional usage hours to lessen any impact to users.

O SAS uses the third Saturday of each month to perform scheduled maintenance on
its systems (if needed). Therefore, the server might be unavailable for a portion of
time on the third Saturday of each month.

To determine if SAS servers are available, visit the SAS Server status Web page:
(https://www.ondemand.sas.com/status/oda/).

Requesting SAS Server availability notification

If you would like to be notified when the SAS Server is unavailable due to extended
maintenance or due to unforeseen circumstances, please subscribe to the
SASONDEMANDSERVER-L mailing list:

1 Send e-mail to LISTSERVELISTSERV.SAS.COM.
2 In the body of the e-mail, type subscribe SASONDEMANDSERVER-L

3 Send the e-mail (no subject line is needed). Follow any instructions you receive via
e-mail.
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To unsubscribe from SASONDEMANDSERVER-L, perform the following steps:
1 Send e-mail to LISTSERVELISTSERV.SAS.COM.
2 In the body of the e-mail, type unsubscribe SASONDEMANDSERVER-L

3 Send the e-mail (no subject line is needed)

Step 4. Prepare course data

The information below will help instructors determine the most suitable option for
providing students with data and exercises that meet their course objectives and
computing environment.

Options for providing course data to students

With SAS OnDemand for Academics: Enterprise Guide, instructors have three options
for providing data for course exercises and teaching examples:

0 Using SAS sample data on the hosted SAS Server
0 Upload their own course data files to the SAS Server

O Providing course data on local file systems

Sample data on the SAS Server

The SAS Server includes various SAS libraries (and their corresponding SAS data sets).
As an instructor, you might want to use one or more of the SAS data sets from
SASHELP, MAPS or other SAS-provided libraries to ensure that all your students have
access to the data.

Follow these steps to view sample data libraries on the SAS Server:

O Log on to SAS Enterprise Guide using your userid and password.
Open or create a new project
Navigate to the Server List’ on the lower left had side of the screen
Select the ‘+’ icon to expand the server list.
Expand SASApp

Expand Libraries

0000 o0 D

Expand the library you would like to use to view the data set you are searching
for.

O Double-click the SAS data set to open it.

Custom course data on the SAS Server

Instructors have the option of uploading data files customized specifically for their
course to hosted SAS Servers. Detailed instructions are provided in this section for
uploading SAS data sets, other data files, and other SAS files types.

Custom course data on local file systems

Instructors or students can store the data that they want to use on a data source that
can connect to their PC. Sources could include a local file system, university space (such
as AFS or NF'S space), or even portable disk drives.

Note: For best performance, SAS recommends that both students and instructors
upload SAS data sets for the course to the SAS Server. Uploading to the SAS Server
will improve data transfer speed and ensure that the step is recorded as part of your
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project. When uploading, instructors may save SAS data sets on the SAS server to be
used for the duration of the course. Students may upload SAS data sets to the SAS
Server for use during a work session. Data that is not stored on the SAS Server will be
added to the temporary Work library, which is only available during that session. Data
changes will not be saved after the project is closed and must be downloaded if you wish
to save them for use in another session.

Requesting assistance with custom course data on the SAS Server

While storing custom course data on the SAS Server is available to all instructors, the
process does require some familiarity with File Transfer Protocol (FTP) applications and
a knowledge of working with SAS filenames. SAS OnDemand for Academics provides
detailed instructions as well as hands-on support.

SAS is available to assist instructors who would like help with uploading their own data
for use within their courses. To request assistance, please send e-mail to
support@sas.com.

SAS will contact you as soon as possible. It might take up to three business days to
upload your data. In your e-mail, please include the following information:

0 Name

College or University

Course Name

Phone Number

Software application being used (for example, SAS Enterprise Guide)

0O 0o 00

Type of data files that you would like to upload

Requirements for storing custom course data on the SAS Server

The SAS Server is Unix-based. You should be aware of naming conventions and how
SAS OnDemand for Academics may handle files names. There are additional
requirements if your course makes use of third-party data.

File names and types

Please note the following requirements for filenames and types:

O Only data files may be stored on the SAS Server (no program files, course notes,
slides, and so on).

O Avoid using this space to store data files from individual students. This space is
intended to store the data files that an instructor wants all students to be able to
access to complete a course.

O Ensure that your data files are named using all lowercase letters. If you use mixed
or uppercase letters, then our hosted servers (which use UNIX) might not detect
the files. For example, mydata.sas7bdat is an acceptable name, but
MyData.sas7bdat is unacceptable. By default, our system will automatically
change the name of your uploaded files to lowercase to avoid any issues.

O Avoid using spaces in data file names. For example, mydata.sas7bdat is an
acceptable name, but my data.sas7bdat is unacceptable. By default, our system
will automatically replace spaces with underscores to avoid any issues.
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O Avoid using special characters (such as parentheses or ampersands) in data file
names.

O You should keep a master copy of your data files in another location.

0 Instructors can store SAS data sets (file type extension of .sas7bdat) as well as
SAS data set index files (file type extension of .sas7bndx) on the SAS Server.

Third party data sources

Some universities purchase third party data sources or use open source third party data
sources. Often, these data sources are protected by specific license agreements or terms
of use. Please review the license agreement or terms of use for the third party data
sources in question prior to uploading this type of data to the SAS Server. It is your
responsibility to:

O ensure that you have the right to upload third party data sources to the SAS
Server

O verify that use of the third party data sources does not violate any third party
rights or any applicable laws or regulations

Uploading course files to the SAS Server

Please follow the instructions in this section for uploading SAS data sets, other SAS
files, and data files that are not SAS data sets onto the SAS Server.

Uploading SAS data sets for your course

To upload a SAS data set to the storage area for your course, you will need to work with
a File Transfer Protocol (FTP) application. If you are unfamiliar with the process, SAS
has provided step-by-step instructions with screen captures.

You are encouraged to print a copy of “SAS OnDemand for Academics: Storing and
Accessing SAS Data Files on the SAS Server, Instructor Guide” at
http://support.sas.com/ondemand/pdf/StoringandAccessingSASFiles.pdf.

Uploading other data formats on the SAS Server

Some SAS software applications, such as SAS OnDemand for Academics: Enterprise
Guide, are designed to use data other than SAS data sets. The following types of data
files can be stored on the SAS Server:

O .asc (text file)

.csv (comma delimited)
.dat (flat data file)

.db (Paradox)

.dbf (dBASE)

.mdb (MS Access)

.tab (text file)

txt (text file)

.wk? (Lotus 123)

00000 0 D0 o
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To upload other data formats to the storage area for your course, you will need to work
with a File Transfer Protocol (FTP) application. If you are unfamiliar with the process,
SAS has provided step-by-step instructions with screen captures.

You are encouraged to print a copy of “SAS OnDemand for Academics: Storing and
Accessing Non SAS Files on the SAS Server” at
http://support.sas.com/ondemand/pdf/StoringandAccessingNonSASFiles.pdf.

Encountering permission denied errors while using FTP

Your FTP client must be in passive mode to work properly. This is the default mode for
most FTP clients. If you access a "permission denied" error while trying to use FTP, then
your FTP client might not be in passive mode. Refer to the online help for your FTP
client to determine how to set passive mode.

Note: If you use the Microsoft Windows Command Line as your FTP client, then you
will likely have to turn passive mode on. To do so, enter the following command after
you have logged on to an FTP site:

literal pasv

Uploading and using directories

You can upload directories to the SAS Server using your FTP client. This might be
useful if you are trying to organize data files for specific purposes, such as grouping the
data used in different course assignments.

If you upload directories to the SAS Server, then the predefined LIBNAME and
FILENAME statements provided for your course will have to be modified to include the
directory name.

For example, if you create and upload a directory called examples, then the name of
this directory would have to be appended to the LIBNAME or FILENAME statement
generated for your course.

If your original course LIBNAME statement had this format:
libname mydata "/courses/u_xxxx/i_xxxxx/c_xxx/saslib" access=readonly;

Your appended course LIBNAME statement would have this format (assuming that the
subdirectory examples was uploaded under the /saslib directory):

libname mydata "/courses/u_xxxx/i_xxxxx/c_xxx/saslib/examples" access=readonly;

Note: Directory names (as well as LIBNAME and FILENAME statements) are case-
sensitive. If you create and upload a directory named Examples, then you must append
Examples (and not examples or EXAMPLES) to your LIBNAME or FILENAME
statement.

Storing SAS catalog files on the SAS Server

Instructors can store SAS catalog files (file type extension of .sas7bcat or .sas7scat) on
the SAS Server and then use them as needed. Since the SAS Server is Unix based,
there are some unique steps that must be followed to use SAS catalog files. Additionally,
you must have access to a local copy of SAS software in order to complete the steps.

The following steps provide an example of how you could create custom formats and a
custom catalog and then upload and use them within SAS OnDemand for Academics.
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1 Create custom formats and then store them in a local directory on your
PC. You must complete this step using a local installation of SAS software
instead of SAS OnDemand for Academics software.

The following sample code creates a custom format and stores a SAS catalog on
your local PC. You can copy and paste the code to try it out (the
C:\TEMPFORMATS directory is used as an example, but could be replaced with a
different directory name):

libname mydata 'C:\TEMPFORMATS';

proc format lib=work;
value custom format

0="'30"
1='31"
2='32"
run;

proc catalog cat=work.formats;

copy out=mydata.formats;

run;

contents cat=mydata.formats;

quit;

filename tranfile 'C:\TEMPFORMATS\transport.dat';
proc cport catalog=mydata.formats file=tranfile;
run;

2 Create a transport file from the SAS catalog that now exists on your PC.
If you have a pre-existing SAS catalog with SAS formats, then you can also use
this step to create a transport file. Use the sample code below to create the
transport file. You can copy and paste the code to try it out:

libname mydata 'C:\TEMPFORMATS';

filename tranfile 'C:\TEMPFORMATS\transport.dat';
proc cport catalog=mydata.formats file=tranfile;
run;

3 FTP the transport.dat file in to your SAS OnDemand for Academics
course directory. Use the procedures found in Storing Other Data Formats on
the SAS Server.

4 Log on to SASOnDemand for Academics: Enterprise Guide. Open a
Program Editor window and then run the following code. You can copy and paste
the code if you wish to try it:

libname mydata "/courses/u x/i xxxxxx/c xxx/saslib";
filename trans2 '/courses/u x/1i xxxxx/c xxx/transport.dat';

proc cimport catalog=mydata.formats infile=trans2;
run;

Note: In the code above, replace the x characters with the numbers that
correspond to your university, instructor, and course numbers. For more
information, see Accessing Data Stored on the SAS Server.

5 Use your custom formats. The formats will persist over multiple sessions. Be
sure to use the FMTSEARCH option when you reference a format. See the
following code example. You can copy and paste the code if you wish to try it:

data myformat;

input a;
cards;

ad wbhNhE O
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run;

options fmtsearch=(mydata);

proc print data=myformat; format a custom format.;
run;

Note: The Code presented above is intended to be used solely as part of a
product ("Software") you currently have licensed from SAS Institute Inc. or one of
its subsidiaries or authorized agents ("SAS"). The Code is designed to either
correct an error in the Software or to add functionality to the Software, but has not
necessarily been tested. Accordingly, SAS makes no representation or warranty
that the Code will operate error-free. SAS is under no obligation to maintain or
support the Code.

Neither SAS nor its licensors shall be liable to you or any third party for any
general, special, direct, indirect, consequential, incidental or other damages
whatsoever arising out of or related to your use or inability to use the Code, even if
SAS has been advised of the possibility of such damages.

Except as otherwise provided above, the Code is governed by the same agreement
that governs the Software. If you do not have an existing agreement with SAS
governing the Software, you may not use the Code.

Accessing course files stored on the SAS Server

The following are instructions for accessing your custom course data once it has been
uploaded.

Accessing data with LIBNAME or FILENAME statements

Once a SAS data set or a data file has been uploaded to the SAS Server, users can access
the data using the appropriate LIBNAME or a FILENAME statement. The LIBNAME
or FILENAME statement to use is provided to you during the course registration
process. You can access this information at any time:

1

2
3
4

Log on to your SAS OnDemand for Academics Home Page.
From the Course table, locate the appropriate course.

Click Info.

Review the section called Working with SAS Data Sets (for the appropriate
LIBNAME statement) or Working with Other Data Formats (for the appropriate
FILENAME statement).

Start SAS OnDemand for Academics: Enterprise Guide.
Create or open a SAS program.

Assign the LIBNAME or FILENAME statement in your code in order to access
your data. Remember LIBNAME and FILENAME statements are case-sensitive.

If appropriate, share the LIBNAME or FILENAME statement with your students
so that they will know which statement to use to access your data.

Note: If you have created and uploaded a directory, then you must append the
directory name to the generated LIBNAME or FILENAME statement for your course.
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Accessing data using SAS OnDemand for Academics: Enterprise Guide

You can access SAS sample data sets using the procedure below. Once you have
submitted a LIBNAME or FILENAME statement, you can access your uploaded course
data using the same method.

Log on to SAS Enterprise Guide using your userid and password.

1

a1 A W N

7

Open or create a new project

Navigate to the Server List’ on the lower left had side of the screen
Select the ‘+’ icon to expand the server list.

Expand SASApp

Expand Libraries

Expand the appropriate library to list SAS data sets (such as MAPS or SASHELP
or the library that you have assigned using a LIBNAME statement).

Double-click the SAS data set to open it.

Listing SAS data sets stored on the SAS Server

If you have uploaded SAS data sets to the SAS Server for a specific course and you want
to see the names and information associated with those SAS data sets, do the following:

1

Identify the LIBNAME statement associated with the course for which you have
uploaded data.

Start a SAS OnDemand for Academics: Enterprise Guide.
Open a Program Editor window from within the application.

Enter and run code similar to the example below. Replace the LIBNAME
statement in the example with the LIBNAME statement that you identified in
Step 1.
libname mydata "/courses/u_ xxxx/i xxxxx/c xxx/saslib" access=readonly;
proc contents data = mydata. all ;
run;
Use the Output window to review the results. The results will identify the SAS
data sets that you have uploaded.

Note: If you have created and uploaded a directory, then you must append the
directory name to the generated LIBNAME statement for your course.

Deleting SAS data sets stored on the SAS Server

If you are an instructor and you have uploaded data that you no longer want to make
available on the SAS Server (or you have exceeded your data storage quota), then you
can delete the data using the following steps:

1
2
3

Identify the location of your course data.
Use SAS Enterprise Guide to access the SAS Program Editor.

Do not append the access = readonly option to the LIBNAME statement when you
plan to delete files. If the LIBNAME statement is submitted as read-only, then
you will be unable to delete the files.

Use the DELETE statement within DATASETS procedure to specify the files
you’d like to remove from the SAS server.
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Note: See online documentation for the DATASETS procedure in the Base SAS
9.2 Procedures Guide at http:/support.sas.com/documentation. Ifyou are
unfamiliar with the DATASETS procedure, you can open a SAS Technical Support
request by sending e-mail to support@sas.com. In your request, please specify
your course as well as the data that you would like to have deleted from the SAS
Server.

Step 5. Review and test Course Materials

Instructors will want to review the software and course materials before the course
begins.

Importance of reviewing the software

In some cases, the steps needed to complete certain tasks might be different when using
SAS OnDemand for Academics software applications (versus traditional SAS software
applications). By reviewing and testing your course materials prior to class, you can
prepare yourself and your students for any minor differences.

Note: While it might take 30 minutes or less to review available course information and
test the information against SAS OnDemand for Academics, you might have to register
for and/or request course materials from SAS (if applicable). This process could take a
few days. Please plan accordingly.

Teaching materials provided by SAS

Instructors may choose to use training materials provided by SAS, or they may choose to
refer to course materials from previous SAS courses.

SAS Education provides certain teaching materials free of charge to instructors at
degree-granting academic institutions. These materials include an electronic copy of
course notes, slides, and in some cases, code and data. The materials are not available
for use by students. Visit Teaching materials from SAS at the Training & Bookstore for
SAS Global Academic Program at http://support.sas.com/learn.

Note: Prior to downloading the course materials, an instructor must register for SAS
OnDemand for Academics. Additionally, instructors will be required to accept a license
agreement that specifies the terms and conditions of usage.

The training materials were developed for users who are running SAS locally. Certain
SAS code examples might not work or might need to be modified for use with SAS
OnDemand for Academics. For example, any referenced SAS data sets would need to be
uploaded to the SAS Server and any LIBNAME statements would have to be modified to
reflect the LIBNAME statement for an instructor's SAS OnDemand for Academics
course.

Practice exercises, statistics information, and sample SAS data sets

For instructions about how to perform all of the basic statistics taught in an
introductory statistics class, libraries of SAS data sets, and a library of practice
exercises, visit the SAS Online Resources for Statistics Education Web site at this
location: http://support.sas.com/learn/statlibrary/.
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Books, training, and other reference materials

SAS Publications are available online at http:/support.sas.com/publishing/. You can
find books, review portions of each book, and place orders.

SAS Publishing offers products to qualified college faculty who are interested in
teaching SAS. For more information, see the Academic Evaluation Copy Program.

For SAS OnDemand for Academics: Enterprise Guide, you may find this white paper
useful in preparing for your course: “Implementing SAS and Enterprise Guide to
Enhance a Graduate Biostatistics Curriculum” at this location:
http://support.sas.com/ondemand/pdf/NESUG06_Implementing EG_Biostats.pdf.

Step 6. Share course information with students

After you create your course, prepare your data, and become familiar with the software,
you should:

O invite your students to register for your SAS OnDemand for Academics course
O provide important information on how to access the course software and data
We recommend that you ask your students to complete these steps prior to the

beginning of your course (if possible) or during the first week of your course. Some
instructors choose to use the first class of a course to review how to perform these steps.

Ask students to register for SAS OnDemand for Academics

When you create a course within SAS OnDemand for Academics, you are presented with
text that you can copy and paste in to an e-mail to send to your students. This text
provides the information that your students will need to register for SAS OnDemand for
Academics and download the appropriate software application.

If you don't copy and paste the text when you initially create a course, you can access
the information again at any time:

1 Log on to your SAS OnDemand for Academics Home Page at
https://support.sas.com/ctx3/sodareg/index.html.

2 Under the Manage Courses area, click the Info link next to the appropriate
course.

3 Select View a sample message.

A generic version of the e-mail text is provided below as an example. You can copy,
paste, and customize this text if needed. For example, if you have a coupon code that
students need to use, you can include that code in your e-mail.

Dear student:

I plan to use SAS® OnDemand for Academics: Software Application Name software to
teach course name.

As a student in my class, you will need to register for SAS® OnDemand for Academics
and then access SAS® OnDemand for Academics: Software Application Name.
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Here's how to get started:

1  Access the SAS OnDemand for Academics Control Center at the following URL:
http://support.sas.com/ctx3/sodareg/index.html

Review the information and follow the steps at this site.

If you have additional questions, review the information about using SAS
OnDemand for Academics at http:/support.sas.com/ondemand or contact me.

Thank you.

Provide students with information about the system

While it is up to you to determine how you want to invite your students to participate,
we recommend that you send e-mail to the students on your course roster. In the e-mail,
it might be useful to:

O highlight system requirements, especially if you think the requirements could be
an issue for some students. Please note that the SAS OnDemand for Academics
products are not supported on Macintosh computers.

O include step-by-step installation instructions.

Suggested information to share with students

How to register for SAS OnDemand for Academics. A printable, step-by-step guide
“SAS OnDemand for Academics: Enterprise Guide, Student Registration Instructions” is
available from http:/www.sas.com/govedu/edu/programs/enterprise_guide_student.pdf.

As an instructor, you might want to share copies of the guide or links to the appropriate
guide with your students.

How to access course data on the SAS Server. If you choose to store data on the
SAS Server, then you must share the LIBNAME or FILENAME statement associated
with that data with your students. For example, you might include the information in
course notes or through e-mail.

Connection Time-outs. An open connection to the SAS Server will likely expire after
an hour of idle time (or less). Firewalls and other security measures often perform these
types of time-outs after one hour (or less). Remind your students that they should save
their work or exit SAS OnDemand for Academics or both before leaving their computers.

Software Order E-mails. Each instructor and each student receives a Software Order
E-mail from SAS when they choose to download SAS OnDemand for Academics:
Enterprise Guide. Each SOE contains a unique order number that is associated with
only one user. The SOE includes the information necessary to download and install the
software, which is done through the SAS Download Manager. Note: Users should not
share their SOEs with other users.

Step 7. Review the hasics for working with data and results

During the first week of class, we recommend that you review with your students the
basics of working with SAS data sets and results in SAS OnDemand for Academics:
Enterprise Guide.
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Working with data

To ensure that students can access course data and that they do not lose their work, you
should cover the basics of uploading and downloading files from the SAS Server.

Storing data

There are two ways to store data for use with SAS OnDemand for Academics:

O If you are an instructor, then you can store data on the SAS Server. After you have
stored this data, students can access the data using a LIBNAME or FILENAME
statement that you provide for them.

O Instructors or students can store the data that they want to use on a data source
that can connect to their PC. Sources could include a local file system, university
space (such as AFS or NFS space), or even portable disk drives.

Uploading data files to the SAS Server.

If the data that you want to use is not already available from the SAS Server, then you
can use the Upload Data Files to Server task available within SAS OnDemand for
Academics: Enterprise Guide.

The Upload Data Files to Server ask enables you to select one or more SAS data sets
(*.sas7bdat) from your local Microsoft Windows file system and copy them to the SAS
Server (the SAS Cloud) for processing. You must perform this step in order to work with
any local SAS data sets because the SAS Server cannot access any data on your local
drives.

The task generates a log that summarizes the data files that were copied, the byte size,
timings for each file and for all of the files as a group, and any errors that occurred
during the transfer. By default, all data files are added as output data in your SAS
Enterprise Guide project so that they can be used in the project.

Note: Since any modifications that you make to the data will not be saved once you end
your session, you might want to download any data files that you have changed from the
SAS Server to your local PC after you have finished your work.

To upload a data set:
1 Select SAS data sets to upload.
2 Specify the upload options.

To select the SAS data sets to upload:

1 Select Tasks » Data » Upload Data Files to Server. The Upload Data Files to
Server window opens.

2 Select Add to select the SAS data sets that you want to copy. The Open dialog box
opens.

3 Select the name of the file that you want to copy. To select more than one file, hold
down the CTRL key while selecting the files that you want to add. Files must be
SAS7BDAT files.

4 Select Open to add the files to the list of data sets that you want to copy. Note that
all files that are copied are given lowercase names on the target server.



SAS OnDemand for Academics: Enterprise Guide  Step 7. Review the basics for working with data and results 23

5 Select Next to specify the upload options. The Upload Data Files to Server window
opens. This window specifies the name of the SAS server and the destination SAS
library for your project. To specify the upload options:

If you want overwrite any existing files on the SAS server that have the same
name as the files that you are copying, select the Overwrite existing files with the
same name check box. By default, existing files are not overwritten.

If you do not want to add the data sets that you are copying to your current SAS
Enterprise Guide project, clear the Add data files to your current project check box.
By default, the copied data sets are added to the current project.

Note: The SAS Server for SAS OnDemand for Academics is selected by default, and
cannot be changed.

Note: The WORK library is the destination SAS library by default and should not
be changed. The WORK library is specified because it is the only location on the
SAS Server that you have the ability to temporarily store data for processing.
Selecting any library other than WORK will result in an error.

6 Select Finish to copy the data sets to the SAS Server. A log is created and appears
in the SAS Enterprise Guide Project Explorer.

Downloading data files from the SAS Server

The Download Data Files to PC task enables you to select one or more SAS data sets
(*.sas7bdat) from the SAS Server and copy them to your local Microsoft Windows file
system. It is important to complete this step if you have modified any SAS data sets that
you want to use again in the future.

The task generates a log that summarizes the data files that were copied, the byte size,
timings for each file and for all of the files as a group, and any errors that occurred
during the transfer.

To download a data set:
1 Select the SAS data sets to download.
2 Specify the download options.

To select the SAS data sets to download:
1 Select Tasks » Data » Download Data Files to PC. The Download Data Files to PC
window opens.
2 Select Add to select the SAS data sets that you want to copy. The Open dialog box
opens.

3 Select the name of the file that you want to copy. To select more than one file, hold
down the CTRL key while selecting the files that you want to add. Files must be
SAS7BDAT files. All files that are copied are given lowercase names in the target
folder.

Select Open to add the files to the list of data sets that you want to copy.

Select Next. The Download Data Files to PC window opens. To specify the
download options, follow these steps:

0 Type the path of the folder to which you want to copy the files or select Browse
to select a folder. The default location is your My Documents folder.
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0 Ifyou want to overwrite any existing files in your PC folder that have the
same name as the files that you are copying, select the Overwrite existing files
with the same name check box. By default, existing files are not overwritten.

6 Select Finish to copy the data sets. A log is created and appears in the SAS
Enterprise Guide Project Explorer.

Accessing data using SAS OnDemand for Academics: Enterprise Guide

The SAS Server includes sample SAS data sets that you might choose to use.
Additionally, if course files and SAS data sets have been uploaded to the SAS Server,
then you can access these SAS data sets as well. To access the SAS data sets, do the
following:

1 Start SAS OnDemand for Academics: Enterprise Guide and log on.
Select File » Open » Data.

Select Servers.

Double click on SAS Apps.

Double click on Libraries.

Double click on the appropriate library (such as MAPS or SASHELP or the library
that you have assigned using a LIBNAME statement).

7 Double click on the SAS data set that you want to use.

Note: Remember that if you modify a SAS data set that exists on the SAS Server and
you want to save that SAS data set, you must download the data set to a local drive. If
you do not, your modifications will be lost when you end your session.

Additionally, some of the SAS data sets available from the SAS Server might be too
large to download locally unless you have modified them to make them smaller. In this
case, it is recommended that you work with the original SAS data sets only while
connected to the SAS Server.
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Accessing grayed-out SAS libraries from the SAS Server

The SAS Server includes sample SAS data sets that you might choose to use. Some of
the sample SAS Libraries might appear to be grayed out, but they are still available for
use.

Typically, grayed out SAS Libraries appear for users in Europe and were originally
intended for use with another SAS software application, such as SAS Enterprise Miner.

1 Start SAS OnDemand for Academics: Enterprise Guide and log on.
Select File » Open » Data.

Select Servers.

Double click on SAS Apps.

Double click on Libraries.
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Right click on the grayed out SAS Library that you would like to access and then
click Assign.

7 Double click on the SAS data set that you want to use.
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Uploading data files to the SAS Server versus opening SAS data sets

If you have access to a local SAS data set, you can choose File » Open » Data and select
the appropriate SAS data set. However, this is not the preferred method. Instead, SAS
recommends that you upload the SAS data set to the SAS Server. This will improve data
transfer speed and it will ensure that the step is recorded as part of your project.

Working with data files other than SAS Data Sets

If you want to work with data other than SAS data sets (such as comma delimited files
or text files), you can import the files in to SAS OnDemand for Academics: Enterprise
Guide. To import files that are not SAS data sets, follow these steps:

1 Select File » Import Data.
2 Select Local Computer.
3 Find and select the data file that you want to use.

Working with compressed SAS Data Sets

SAS does not recommend that you work with compressed SAS data sets when using
SAS OnDemand for Academics: Enterprise Guide. If you have a compressed SAS data
set, you can use the COMPRESS=NO option to remove compression.

Assigning LIBNAME and FILENAME statements

The SAS Server is unable to recognize or access the local drives of your PC. Therefore, if
your SAS program includes a LIBNAME or FILENAME statement that refers to a local
path (such as a location on your C: drive), then you will receive processing errors.

Instructors have the ability to store SAS data sets and other data files on the SAS
Server. If your instructor has taken advantage of this feature, then you will receive
either a LIBNAME statement or a FILENAME statement from your instructor that you
can use to access the appropriate data.

Note: LIBNAME or FILENAME statements are case-sensitive. Please copy them or
type them in exactly as they appear to avoid permissions errors.

If you do have local SAS data sets that you want to use, it is recommended that you
upload them. You can then refer to the uploaded SAS data sets in your code or in your
projects. Additionally, if you modify the SAS data sets that you upload and you want to
use them again, you should download the SAS data sets from the SAS Server prior to
exiting SAS OnDemand for Academics.

Working with INFILE statements

An INFILE statement identifies an external data file to read with an INPUT statement.
If you plan to use an INFILE statement or are asked to use an INFILE statement to
access data, then you must use a fully qualified path in your statement.

For example, if country.dat exists in a course directory called
/courses/u_0/i 123/c_ 105, then the INFILE statement to access this data file
would be:

infile '/courses/u 0/i 123/c_105/country.dat';
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However, if you specified a path that is not fully qualified (such as the following), then
an error would be produced:

infile ‘country.dat’;
If you are an instructor and you have uploaded data to the SAS Server for a specific

class, then you can find the fully qualified path to your uploaded data by doing the
following:

1 Log on to your SAS OnDemand for Academics Home Page.
2 Under the Manage Courses area, click the title of the appropriate course.

3 Scroll to the Course Data Directory area and then click How to use this
directory.

4 Review the information to identify the LIBNAME or FILENAME statement for
your course.

This information also identifies the fully qualified path for your course data. For
example, a FILENAME statement for a specific course might look like the
following:

filename sample "/courses/u 0/i 123/c_105/sample.csv";

From this FILENAME statement, we can determine that the fully qualified path
is

courses/u 0/i 123/c 105
5 If appropriate, share the fully qualified path with your students so that they will

know which path to use in their INFILE statement. Please note that INFILE
statements are case-sensitive.

If you are a student, then you must use the INFILE statement (with the fully qualified
path) that your instructor provides. Only instructors have the ability to upload data files
to the SAS Server.

Working with INFILE statements and Microsoft Windows data files

If you import or upload a raw data file (such as a text file or a comma separated value
file) from a PC using the Microsoft Windows operating system, the file might contain
carriage-return characters. These carriage-return characters will cause errors when you
attempt to read the file on the UNIX version of SAS used by SAS OnDemand for
Academics servers.

For example, using the following INFILE statement could cause data processing or data
display errors:

infile newemps dlm="',';
These errors can be avoided by using the following INFILE statement:
infile newemps dlm=',' TERMSTR=CRLF;

For more information about the TERMSTR option, search for TERMSTR in SAS 9.1.3
Online Documentation at http://support.sas.com/documentation.

Saving Data

SAS OnDemand for Academics provides instructors with the ability to store data (if they
choose to use this feature). This stored data can be used during subsequent sessions.
However, if you created or modified a SAS data set that you want to be able to use in
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future SAS OnDemand for Academics: Enterprise Guide sessions, then you must save
that SAS data set locally before ending your session.

Saving Work

SAS OnDemand for Academics: Enterprise Guide is unable to store your work on the
SAS Server (the SAS Cloud). Instead, you must save any work (SAS Enterprise Guide
projects, SAS files, output files, and so on) to a hard disk drive that you can access prior
to ending your session.

To save any work within SAS OnDemand for Academics: Enterprise Guide, start by
selecting one of the following options:

Q To save a file, choose File » Save or File » Save As

O To save a project, choose File » Save Project or File » Save Project As

Working with Results

With SAS OnDemand for Academics: Enterprise Guide, you have the ability to select the
type of result format that you want to produce. By default, the result format is set to
HTML.

Working with the PDF result format

If you choose to use the PDF result format, then certain graphics will appear distorted
unless you also change the default graph format to GIF or JPEG.

Complete the following steps if you want to use the PDF result format and ensure that
graphs render appropriately:

1 Open SAS OnDemand for Academics: Enterprise Guide.

Select Tools » Options.

From the left side of the screen, select Results General from the tree.
Select PDF.

From the left side of the screen, select Graph from the tree.

From the Graph Format drop down menu, select GIF or JPEG.
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Result formats and associated graph formats

The default graph format is ActiveX, which typically provides the best results for HTML
and SAS Report result formats. If you need to use a result format such as PDF, which
does not support interactive graphics types, you will also need to change the graph
format to a static device type such as GIF or JPEG. The following table references result
formats and the graph formats that each supports:

Result Format Supported Graph Formats
ActiveX, Java, GIF, JPEG, SAS

HTML EMF

SAS Report ActiveX, GIF, JPEG

PDF GIF, JPEG, SAS EMF

RTF ActiveX, GIF, JPEG, SAS EMF

Text (Listing) None

Step 8. Finding Help for Common Problems

Please check the commonly asked questions about SAS OnDemand for Academics:
Forecast Server in this section and follow the procedures below for additional help.

Where can instructors find help?

Please follow the steps below to resolve any technical issues.

Step 1: Review Commonly Asked Questions, SAS Notes, and SAS Documentation

Use the key word ‘ondemand academics’ to search for issues specific to SAS OnDemand
for Academics from these sources:

0 Commonly Asked Questions about SAS® OnDemand for Academics in this manual

0O SAS Notes, a database of common technical issues found at
http://support.sas.com/notes/

O SAS Product Documentation on http://support.sas.com/documenation

Step 2: Contact Your SAS Site Representative (if applicable)

If you are an instructor at a university that already uses SAS Software, then you might
have a SAS Site Representative who can provide SAS support.

If you are unsure about whether you have a SAS Site Representative, contact the person
or department that supports your university's software purchases and installation.
Step 3: Contact SAS Technical Support (Instructors)

SAS Technical Support is designed to assist you with technical issues such as
installation or setup questions. They are not available for providing training or
answering basic usage questions.
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If the above steps have not resolved your issue, please contact SAS Technical Support:

1 Open the SAS Technical Support Problem Form found on
http://support.sas.com/techsup/

2 Fill out and submit the form. When filling out the form, use the following values:
Q For Company Name, enter SAS OnDemand for Academics.
Q For Site Number, enter 00700315

Optionally, e-mail your support request to support@sas.com. Be sure to specify that
you are using SAS OnDemand for Academics.

Where can students find help

Students should be asked to follow the steps below to resolve any support issues they
encounter:

Step One: Review Commonly Asked Questions, SAS Notes, and SAS Documentation

Use the key word ‘ondemand academics’ to search for issues specific to SAS OnDemand
for Academics from these sources:

0 Commonly Asked Questions about SAS OnDemand for Academics in this manual

0O SAS Notes, a database of common technical issues found at
http://support.sas.com/notes

O SAS Product Documentation on http://support.sas.com/documentation

Step Two: Contact Your Instructor

If you are a student and you have questions about using SAS OnDemand for Academics,
contact your instructor. Instructors can point students toward educational resources and
help ensure that offerings are used correctly.

If further assistance is needed, then your instructor can contact SAS Technical Support.

Commonly Asked Questions: SAS OnDemand for Academics: Enterprise
Guide

0 Does SAS OnDemand for Academics: Enterprise Guide have all the same features
as SAS Enterprise Guide?

Certain features of SAS OnDemand for Academics: Enterprise Guide have been
disabled because they are not practical in this setting. For example, the ability to
schedule projects is not available. Note that the online help system documents all
SAS Enterprise Guide features, including those that might be unavailable in this
offering.

O Can I download SAS OnDemand for Academics clients on to more than one
machine?

Yes. For example, you might download a client on to a personal computer at home
as well as a laptop if you use both machines to complete assignments.



30 Step 8. Finding Help for Common Problems  Chapter 2

O I'm using the keyboard to install SAS OnDemand for Academics: Enterprise
Guide. How do I change focus on the initial installation window?

O When the initial installation window appears, the focus is on Step 1: Verify
System Requirements. To select this option, press ENTER.

O After Step 1 has completed, you must press TAB to move focus to Step 2
(Install SAS Enterprise Guide).

Q After you have moved the focus to Step 2, press ENTER to begin the SAS
Enterprise Guide installation process.

O I have installed SAS OnDemand for Academics: Enterprise Guide, but I am not
getting prompted to log on to it when I start the application. What should I do?

Please make sure that you ran the System Requirements Wizard during
installation. When you start the process of installing SAS OnDemand for
Academics: Enterprise Guide, an initial installation window provides you with two
choices:

1 Verify System Requirements
2 Install SAS Enterprise Guide

If you did not perform Step One (Verify System Requirements), then Microsoft
.NET 1.1 will not be installed and will likely cause the error that you are
experiencing.

To correct the situation, simply start the setup.exe file that you downloaded from
the SAS Download Manager. When the installation window appears, choose Step
One. After the System Requirements Wizard runs and installs Microsoft .NET 1.1
on your machine, then you should be able to use SAS OnDemand for Academics:
Enterprise Guide.

Note: If Microsoft .NET 1.1 hangs during the installation process, then please
follow the instructions in SAS Note 16884 at http://support.sas.com/notes/.

For more information and possible answers to your issue, please review the
following SAS Usage Notes:

a SAS Note 34715
a SAS Note 20939
a SAS Note 20437

O I am getting an error when attempting to run SAS OnDemand for Academics:
Enterprise Guide after installing it on Microsoft Windows Vista. What should I
do?

Please make sure that you ran the System Requirements Wizard during
installation. When you start the process of installing SAS OnDemand for
Academics: Enterprise Guide, an initial installation window provides you with two
choices:

Q Verify System Requirements.
Q Install SAS Enterprise Guide

If you did not perform Step One (Verify System Requirements), then Microsoft
.NET 1.1 Vista might include a newer version of the Microsoft NET Framework
that is incompatible with SAS OnDemand for Academics: Enterprise Guide.

To correct the situation, simply start the setup.exe file that you downloaded from
the SAS Download Manager. When the installation window appears, choose Step
One. After the System Requirements Wizard runs and installs Microsoft NET 1.1
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on your machine, then you should be able to use SAS OnDemand for Academics:
Enterprise Guide.

Note: If Microsoft NET 1.1 hangs during the installation process, then please
follow the instructions in SAS Usage Note 16884.

0 Ihave installed SAS OnDemand for Academics: Enterprise Guide, but I receive
the following error when I try to run the application: “The SAS workspace
manager is not installed or registered on this machine....” What should I do?

This issue is most prevalent with users who are running the Microsoft Windows
Vista operating system. If you encounter this message, then download SAS
Integration Technologies Client for Windows.

After you download the client, right click on the file and choose Run as
Administrator (if possible). Otherwise, simply double-click on the file to install the
client.

If the above task does not fix the issue, please verify that you have properly
installed the Microsoft .NET 1.1 Framework. Click here for more information.

O How do Ilog on to SAS OnDemand for Academics: Enterprise Guide?

When you open SAS OnDemand for Academics: Enterprise Guide, The Credentials
Required window appears:

Credentials Required }

SAS Metadata Repository
sascloud.sas.com

User: |j|:|hn.smith )/)

Paszward: I xxxxxxxx

(]9 I Cancel |

You must use this window to log on to the SAS Server (the SAS Metadata
Repository) so that you can perform SAS processing.

~ Getting Started

A Your SAS Server userid it sas.instructor

Use this userid when you log on w wie SAS Server.

= Register a course:
Registering a course will make it available to your students.

To edit course information or review helpful details about courses, click on the course title. To obtain the software for a course
select the link in the Download column.
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To log on, enter the following information:

1 In the User field, enter your SAS Server user ID. This user ID is also displayed on
your SAS OnDemand for Academics Home Page:

2 In the Password field, enter your SAS Profile password. There are two times
when you might have supplied a SAS Profile password: either when you originally
created a SAS Profile or when you registered for SAS OnDemand for Academics.

0 How do I find out more information about using SAS OnDemand for Academics:
Enterprise Guide?

After you have downloaded and installed the client software application that you
plan to use, you can refer to the options on its Help menu. You can also refer to
the “Resources for SAS OnDemand for Academics” appendix in this manual.

0 Can I access the Program Editor, Log, and Output windows using SAS OnDemand
for Academics: Enterprise Guide?

Yes. You can access and use traditional SAS Programming windows. For example,
select File » New » Program or File » Open » Program to access the Program
Editor. After you run a SAS program, the Log and Output windows will display (if
appropriate).

0 Will SAS OnDemand for Academics: Enterprise Guide work if I already have SAS
Enterprise Guide installed on my computer?

Yes. Both versions can be installed on the same computer and will work
independently.

0 How do I work with data in SAS OnDemand for Academics: Enterprise Guide?

SAS OnDemand for Academics: Enterprise Guide works in conjunction with the
SAS Server. The easiest way to work with data is to ensure that the SAS Server
has access to that data. You can do this by using existing sample data sets on the
SAS Server, uploading data files to the SAS Server, or accessing data that an
instructor has chosen to store on the SAS Server.

0 How do I share data with other users who are using SAS OnDemand for
Academics: Enterprise Guide?

If you have data that you want to share with other users, you must place it in a
location that others can access, such as a shared network drive. Users can then
access the data in one of two ways:

O Users can select File » Open, and then choose Project, Data, or Program. A
user can then select the Local Computer source and navigate to the drive and
directory path that contains the data that you want them to use.

Q Users can select Tasks » Data » Upload Data Files to Server. The user will
be given the option of navigating to the appropriate drive and directory to find
the SAS data set that you want them to use. This data will then be uploaded to
the SAS Server and made available for processing.

Note: This is the preferred method for sharing SAS data sets because it is
faster than opening a SAS data set.

Instructors also have the ability to store data on the SAS Server. Once the data is
stored, instructors can share a LIBNAME or FILENAME statement with users so
that they can access the data.

O How do I upload local Data Files from my PC to the SAS Server?

You can use SAS OnDemand for Academics: Enterprise Guide to upload local SAS
data sets to the SAS Server for processing. From SAS Enterprise Guide, select
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Tasks » Data » Upload Data Files to Server. Then follow the steps in the
wizard that appears. Refer to “Uploading files to the SAS Server” for SAS
OnDemand for Academics: Enterprise Guide.

O How do I download Data Files from the SAS Server to my PC?

You can use SAS OnDemand for Academics: Enterprise Guide to download SAS
data sets from the SAS Server to your PC. From SAS Enterprise Guide, select
Tasks » Data » Download Data Files to PC. Then follow the steps in the
wizard that appears. Refer to “Downloading files to the SAS Server” for SAS
OnDemand for Academics: Enterprise Guide.

O Iam an instructor. I don't see the SAS data sets that I am storing on the SAS
Server from within SAS OnDemand for Academics: Enterprise Guide. What's
wrong?

If you uploaded SAS data sets to the SAS Server that have mixed case or
uppercase names, then these SAS data sets might not be visible (even though you
could still refer to them using SAS code). You can rename the appropriate SAS
data sets and upload them to the SAS Server again to correct the issue.

O Can I use data other than SAS data sets?

Yes. If you want to work with data other than SAS data sets (such as comma
delimited files or text files), you can import the files in to SAS OnDemand for
Academics: Enterprise Guide. To import other data, follow these steps:

1 Select File » Import Data.
2 Select Local Computer.
3 Find and select the data file that you want to use.

Additionally, if your instructor has stored data files other than SAS data sets on
the SAS Server, then he or she will provide you with a FILENAME statement that
you can use to access the data.

QO I am an instructor. Can I store Microsoft Excel files (.xIs) on the SAS Server?

No. If you need to store data that exists within a Microsoft Excel file (.xls) and
then access it using a FILENAME statement, we suggest you first save the
Microsoft Excel file as a comma separated value (.csv) file. You can then store the
.csv file on the SAS Server. For more information, see the following topics:
“Accessing data with FILENAME statements” and “Uploading other data formats
on the SAS Server” for SAS on Demand for Academics: Enterprise Guide.

O Iam trying to use an INFILE statement to access data, but it is causing errors.
How should I use an INFILE statement?

You must use a fully qualified path when using an INFILE statement within SAS
OnDemand for Academics: Enterprise Guide. Additionally, INFILE statements are
case-sensitive. Please ensure that you are entering the INFILE statement
appropriately. Refer to “Working with INFILE statements” for SAS OnDemand for
Academics: Enterprise Guide.

O I uploaded a file and am referring to the file using an INFILE statement, but not
all of the fields are being read correctly. What is happening?

This could be the result of uploading a text file or a comma separated value file
from a PC that uses the Microsoft Windows operating system. Adding the
TERMSTR option to your INFILE statement might correct the issue.
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0 I have copied code in to the code (Program) window, but I am getting errors when I
try to run the code. What is happening?

This could be the result of hidden or special characters in the code that you copied
in to the Code window. One way to resolve this issue is to simply type in the code
instead of copying the code. If the amount of code is too much to type, then you
could try saving the code as a text file to remove any special characters or
formatting and then copying the code in to the Code window. For more
information and options, search for SAS Note 16658 on
http://support.sas.com/notes.

0 How do I save my projects or files from within SAS OnDemand for Academics:
Enterprise Guide?

You must save all your work to your local computer because any work you have
completed (and any data that you have uploaded to the SAS Server, if applicable)
will be lost when you end your SAS OnDemand for Academics session.

When you choose to save your work or if you are prompted to save your work,
select Local Computer instead of SAS Servers, and then proceed to save your
work to the appropriate local directory.

O Ireceived an error message when trying to save work using SAS OnDemand for
Academics: Enterprise Guide. What's wrong?

You may receive an error message such as this:

“An error occurred saving the file. Location must be configured as a WebDAV
URL”

In this case, it's likely that you were trying to save your work to the SAS Servers
instead of to your local computer. To avoid this error when you save your work,
select Local Computer instead of SAS Servers. You can then select the local
directory to which you want to save your work.

0 I'm using Output Delivery System (ODS) statements in SAS OnDemand for
Academics: Enterprise Guide in order to write results files (PDF, RTF). How do I
save these files locally?

With SAS OnDemand for Academics: Enterprise Guide, you are unable to write
ODS statements that direct files to your local directories. All SAS statements will
run on the SAS Server only. However, you can enable different output results
formats:

1 Select Tools » Options.
2 From the tree on the left side of the window, select Results.
3 Select the results format(s) that you want to produce, such as PDF or RTF.

Your SAS code will now produce the output results that you selected and
download them from the SAS Server. To save these results permanently, right
click on each results file and then select Export.

Note: Due to graph device restrictions on the SAS Server, if your PDF output
contains any charts, then you will need to specify GIF or JPG as the graph device
format.

0 Can I convert the HTML or SAS Report output that I produce with SAS
OnDemand for Academics: Enterprise Guide into PDF files?

There is no way to accomplish this from within SAS OnDemand for Academics:
Enterprise Guide. However, you could export the output files and then use a
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freeware PDF printer driver to accomplish this goal. To export your output, right
click on the appropriate file and then select Export.

0 How do I view or print multiple output files at the same time using SAS
OnDemand for Academics: Enterprise Guide?

There are two ways to combine results to make one “viewable/printable”
document:

Q Select Tools » Create HTML Document. This option lets you take the
HTML output files you've created in your project and combine them into a
single HTML document, which you can save and print.

O Select File » New » Report. This option works only when you use SAS Report
instead of HTML as your output format. SAS Report output looks like HTML
on the screen, but prints like a PDF (page-oriented). The report builder
interface enables you to combine output from various tasks, arrange the
output the way you like, add headers and footers and images, and control
aspects of page layout and margins.
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SAS OnDemand for Academics: Enterprise Miner

This manual guides instructors through recommended steps for registering for SAS
OnDemand for Academics, preparing to teach courses, and supporting students while
using SAS software.

Step 1. Confirm system requirements

Check these guidelines to ensure your students can access the software.

Confirm requirements for full support

Instructor and student systems must meet these requirements for SAS OnDemand for
Academics: Enterprise Miner to be fully supported.

Supported Not Supported
Operating systems Any system that supports the Sun Macintosh operating systems
Microsystems (Oracle) Java Runtime Note: Virtualized environments
Environment (JRE). Typically, this might not work. Itis
includes Unix, Linux, and various Microsoft recommended that supported
Windows operating systems, such as operating systems run on a
Microsoft Windows XP and Microsoft physical CPU.
Windows Vista.
Java Runtime Java Runtime Environment (JRE) Version JRE 1.6.0_20 is not compatible.
Environment 1.6.0_18. Note: Other JREs from the 1.6
Note: You will be prompted to check for series might series might work.
this JRE and install it when you access
SAS Enterprise Miner.

Hard disk space At least 50 MB of free hard disk space
Internet browser Any browser that supports JRE 1.6.0_18
Internet High speed, including broadband (cable),
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Supported Not Supported

connection DSL (phone), and wireless connections.
Note: Individual usage experience
depends on speed and reliability of

connection.
Network For best performance, at least 1000 Kbit/sec
bandwidth is recommended.

Verify network performance

If you plan to teach in a lab or a seminar setting in which many students will access and
use SAS OnDemand for Academics software applications at the same time, then you
should verify the performance of the network that you plan to use (Internet bandwidth,
wireless router capacity, and so on). If the network performance is not sufficient, then
your students could experience slow or dropped connections to the hosted SAS Servers
that are used to perform SAS processing.

You can contact the appropriate network or IT department personnel to request
additional information. Share the following information with them to ensure they gather
accurate data:

O Type of network connection you plan to use (Wireless, LAN, or other) In
particular, wireless networks can be problematic as there are sometimes stricter
limits to the capacity of concurrent users that they can support.

O Number of students that will use SAS OnDemand for Academics concurrently

O Location of the lab or seminar

O Location of the hosted SAS Servers (the answer is: Cary, North Carolina at SAS
Institute)

There are also a number of tools available through the Internet that you or the
appropriate network personnel can use to check network performance. SAS also offers a
tool that might help. To access this tool, perform the following steps:

1 Go to the following Web site: http://netcheck.sas.com/ookla.
2 Select Test 3.

To run SAS OnDemand for Academics: Enterprise Miner, SAS recommends that your
bandwidth is close to 1000 Kbit/sec or more. If you have less than 1000 Kbit/sec, then
the software should still work, but will likely run slowly.

Note: If you are not teaching in a lab or seminar setting, then each student must
connect to the hosted SAS Servers to perform processing using their own high-speed
Internet connection. If individual students have network connection issues, they can try
to use a computer on a different network or contact their Internet Service Provider.

Verify and install a Java Runtime Environment (JRE)

After you have created a course (if you are an instructor) or registered for a course (if
you are a student) that uses SAS OnDemand for Academics: Enterprise Miner, you must
verify that you have an appropriate Java Runtime Environment (JRE) installed or
install an appropriate JRE. This process needs to be completed only once.

Note: Consider printing these instructions before you begin as some of the steps might
require you to move to other Web sites.
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Step One: Verify whether a JRE (and Java Web Start) is installed
To verify whether you have a JRE installed, try the following:

1 Open a Command Prompt window. Select Start » Run.
2 Type CMD in the Run window.

3 On the Command Prompt window, type start javaws.

4

If the above command opens a Java Web Start window similar to the following,
then you have a JRE (and Java Web Start) installed.

Java(TM) Web Start 1.6.0_06 ll

\]‘3) Usage: javaws [run-options] <jnlp-file=
javaws [contral-options]

where run-options include:

-verbose display additional output

-offline run the application in offline mode

-system run the application From the swstem cache only
-¥nosplash run without showing a splash screen
-J=option= supply option ko the vm

-k start java process and wait Far its exit

control-options include:

~yigwer show the cache viewer in the java control panel
-uninstall remove all applications From the cache
-uninstall <jnlp-file = remove the application from the cache

-impork [import-opkions] <jnlp-file=  import the application ko the cache

import-options include:

-silent import silently (with no user interface)
-system import application into the system cache
-todebase =url> retrieve resources from the given codebase
-shiorbout inskall shortouts as if user allowed prompt
-association install associations as if user allowed prompt

If you have a JRE installed, then continue to Step Two.

If the above command did not work, then you likely do not have a JRE installed.
Continue to Step Three.

Step Two: Ensure that you are using only the recommended Java Runtime
Environment
We recommend that you use Java Runtime Environment (JRE) 1.6.0_18 to run SAS

OnDemand for Academics: Enterprise Miner. Only JREs with U.S. Export Control
Classification Numbers of 5D992 are approved for use with SAS products.

Note: Other JREs from the 1.6 series might also work (excluding JRE 1.6.0_20, which
is incompatible).

1 From a Command Prompt window, start Java Web Start. Type start javaws -
viewer and then press ENTER.

2 Ifthe Java Cache Viewer window appears, close it so that you can see the Java
Control Panel window. The Java Control Panel window often opens behind the
Java Cache Viewer window.

3 From the Java Control Panel window, select the Java tab.
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4 From the Java Application Runtime Settings area (the bottom half of the
window), click View (the second “View” button on the window).

5 In the Enabled column, check only one JRE (uncheck any other JREs that are
checked). We recommend that you check JRE 1.6.0_18.

If JRE 1.6.0_18 is unavailable, then you can test SAS OnDemand for Academics:
Enterprise Miner with your current JRE. To do so, you can start from your SAS
OnDemand for Academics Home Page.

If your current JRE does not work or if you want to install the recommended JRE,
continue to Step Three. Otherwise, configuration is complete.

Step Three: Install the recommended Java Runtime Environment and Java
Web Start

Installing the recommended JRE will also install Java Web Start on your system.

Note: If you completed Step Two above, repeat this step to ensure that only JRE
1.6.0_18 is selected.

1 Access the Java SE Downloads Web Site.

http://www.oracle.com/technetwork/java/javasebusiness/downloads/java-
archive-downloads-javase6-419409.html#jre-6ul8-oth-JPR

Alternatively, you can access the Java SE 6 Downloads archive page at

http://www.oracle.com/technetwork/java/archive-139210.html, then click Java SE
6. On the Java SE 6 Downloads page, select Java SE Development Kit SE 6ul8
from the list.

Click the radio button to Accept License Agreement.
Select jre-6ul8-windows-i586.exe under Download column.

You will be prompted to sign in to your Oracle Web account. If you do not have an
account, you will be prompted to create one.

5 After you are signed in, launch the download and select Run to begin the
installation process.

6 (Optional) If you completed Step Two above, repeat this step to ensure that only
JRE 1.6.0_18 is selected.

Step 2. Set up your SAS OnDemand for Academics account

As an instructor, there are several important steps you must follow to set up a SAS
OnDemand for Academics account, such as creating a SAS Profile account and
registering yourself and your course. The online process uses a series of windows to
guide you.

About the SAS OnDemand for Academics Gontrol Center

Your starting point for accessing SAS OnDemand for Academics is the SAS OnDemand
for Academics Control Center Web site: http:/support.sas.com/ctx3/sodareg/index.html

As an instructor you will use the Control Center to register your account, create
courses, view course information, edit course information, and delete courses. Your
students will use it to register, acquire a license, and view course information.
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Your SAS OnDemand for Academics Home Page is created during the registration
process and is part of the SAS OnDemand for Academics Control Center. You will be
taken to your Instructor Home Page once you have set up an account. You access your
home page to register, view, or edit information associated with courses.

About your SAS Profile account

A SAS Profile is an account that you can create to access specific information and
resources from the SAS Web site. If you are a current SAS user, you might already have
a SAS Profile account. If you are a new SAS user, a SAS Profile is created for you when
you register for SAS OnDemand for Academics.

An important part of your SAS Profile account is a SAS Profile password that you are
prompted to enter each time you access the SAS OnDemand for Academics Control
Center.

Note: Your SAS Profile password must be changed every 6 months for security
purposes. You will receive an e-mail when your password is approaching expiration. To
reset your SAS profile, visit My SAS Profile page at this location:
https://www.sas.com/profile/user/login.htm.

Important information hefore you begin

As you begin setting up your account, it’s helpful to keep the following in mind:

O You will need access to your e-mail account. When you begin registration, you will
be prompted to enter an e-mail address. Enter the e-mail address of an account
that you can access easily while completing your registration.

O You will receive an e-mail during the initial registration process that you must
open and act upon to continue. The e-mail prompts you to click a link to verify
your e-mail address. Its primary purpose is to confirm that you are using a valid e-
mail address and that someone else is not attempting to register you without your
knowledge.

0 If you do not receive the e-mail, please check your junk e-mail folder.

Register as an instructor

Only instructor accounts have the ability to create, edit, or delete courses. If a teaching
assistant is going to act as an instructor, then they must register as an instructor. A
unique e-mail address must be used for the instructor account if the teaching assistant
already has a student account.

There is no cost or obligation associated with registering as an instructor, and following
these steps prepares you to use this offering and provide better guidance for your
students:

1 Go to the SAS OnDemand for Academics Control Center
http://support.sas.com/ctx3/sodareg/index.html

Enter New User.
Follow the online prompts to create your SAS profile.

Continue with your registration until you arrive at your Instructor Home Page.

Sl B W N

Once on your Home Page, you can then register a course.
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Register a course

You must register your course to:
O select and get access to the SAS software that you plan to use
O create course information that you can share with potential students

O create a SAS Forecast Server environment, or collaborative area, for use during
the course.

Note: To avoid confusion and unnecessary support calls, it is important to complete
this step before you invite students to register for SAS OnDemand for Academics When
students register, they must select a university, an instructor, and a course. If you invite
students to register before you have registered a course, they won't be able to select your
course.

1  Go to the SAS OnDemand for Academics Control Center
http://support.sas.com/ctx3/sodareg/index.html

Log on using your e-mail address and your SAS Profile password.
You will arrive at your Instructor Home Page.

Click Register a Course and then follow the instructions.

Step 3. Access and use the software

By accessing using the software ahead of time, you will be able to anticipate possible
student issues, develop content that might be specific to using SAS OnDemand for
Academics, and have an understanding of how long it should take students to access the
software themselves.

Ideally, you should perform this step before you develop your course outline as SAS
OnDemand for Academics software applications function slightly differently than their
traditional SAS software counterparts. There are a number of resources available to
help you.

Access your SAS OnDemand for Academics account

Your SAS OnDemand for Academics account enables you to view and/or edit information
associated with courses. You will have access to this information after you have initially
registered for SAS OnDemand for Academics.

To access an existing SAS OnDemand for Academics account:

1  Access the SASOnDemand for Academics Control Center at the following Web
site: http:/support.sas.com/ctx3/sodareg/index.html

2 Enter your e-mail address and your SAS Profile password and then click Enter.
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Access SAS Enterprise Miner

After you have configured your system to support SAS OnDemand for Academics:
Enterprise Miner, you can start the application by following these steps:
1 Log on to your SAS OnDemand for Academics Home page.

2 From the Manage Courses area, select Get Software next to the appropriate
course. Selecting this link will open a window that includes information about how
to configure your system as well as how to start the application.

3 Click the link that is used to start SAS OnDemand for Academics: Enterprise
Miner (http://emcloud.oda.sas.com:16098/EnterpriseMiner/main.jnlp) .

4 Ifyou are presented with a security warning such as the following, select Run.

F
The application's digital signature has an error. Do you '
want to run the application? e

Hame: SAS Enterprize Miner 5.3
Publisher: SA% Institute Inc.

From: http: ffemcloud oda sas com 16098

[ ilways trust cortent from this publisher |

Run Cancel

@ The digital signature was generated with a trusted certificate but
.

4 More Information...
has expired

5 In the User Name field, enter your SAS Server user ID. This user ID is also
displayed on your SAS OnDemand for Academics home page:

* Getting Started

A Your SAS Server userid it sas.instructor

Use this userid when you log on w e SAS Server.

= Register a course:
Registering a course will make it available to your students.

To edit course information or review helpful details about courses, click on the course fitle. To obtain the software for a course
select the link in the Download column.

Note: Your SAS Server user ID is case sensitive and should be entered in all
lowercase. If you enter your SAS Server user ID using uppercase or mixed case
letters, you might be able to log on, but certain tasks might not perform properly.

6 Inthe Password field, enter your SAS Profile password. There are two times
when you might have supplied a SAS Profile password: either when you originally
created a SAS Profile or when you registered for SAS OnDemand for Academics.

7 Click Log On.
To start SAS OnDemand for Academics: Enterprise Miner in the future, you can perform

the previous steps or simply save the following URL as a bookmark and use it:
http://emcloud.oda.sas.com:16098/EnterpriseMiner/main. jnlp.
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Access the SAS Server

You are prompted to connect to the SAS Server each time you start SAS OnDemand for
Academics: Enterprise Miner. The server (which is hosted at SAS Institute Inc.)
remotely processes any submitted SAS files or projects and returns results to your
computer.

Make sure that you have a working Internet connection if you are unable to use a SAS
OnDemand for Academics software application to perform processing. If your internet
connection is working normally, it is likely that the SAS Server is temporarily
unavailable. Please try to use the server again later. You can also log on to the SAS
OnDemand for Academics Control Center. The SAS OnDemand for Academics Control
Center typically provides a message if the SAS Server is unavailable or expected to be
unavailable in the near future.

SAS Server maintenance and availability

SAS makes its best efforts to make the server available as much as possible and to keep
unexpected downtime to a minimum. There could be limited times when the server is
unavailable because SAS is performing maintenance, testing, or performance
enhancement tasks.

O Ifserver maintenance is needed, SAS will try to perform this work during
nontraditional usage hours to lessen any impact to users.

O SAS uses the third Saturday of each month to perform scheduled maintenance on
its systems (if needed). Therefore, the server might be unavailable for a portion of
time on the third Saturday of each month.

To determine if SAS servers are available, visit the SAS Server status Web page:
(https://www.ondemand.sas.com/status/oda/).

Requesting SAS Server availability notification

If you would like to be notified when the SAS Server is unavailable due to extended
maintenance or due to unforeseen circumstances, please subscribe to the
SASONDEMANDSERVER-I mailing list:

1 Send e-mail to LISTSERVERLISTSERV.SAS.COM.
2 In the body of the e-mail, type subscribe SASONDEMANDSERVER-L

3 Send the e-mail (no subject line is needed). Follow any instructions you receive via
e-mail.

To unsubscribe from SASONDEMANDSERVER-L, perform the following steps:
1 Send e-mail to LISTSERVRLISTSERV.SAS.COM.
2 In the body of the e-mail, type unsubscribe SASONDEMANDSERVER-L

3 Send the e-mail (no subject line is needed)

Step 4. Prepare course data

The information below will help instructors determine the most suitable option for
providing students with data and exercises that meet their course objectives and
computing environment.



46 Step 4. Prepare course data Chapter 3

Options for providing course data to students

With SAS OnDemand for Academics: Enterprise Guide, instructors have three options
for providing data for course exercises and teaching examples:

0 Using SAS sample data on the hosted SAS Server
O Using SAS data sets from publically offered SAS Enterprise Miner courses
0 Uploading your own course data to the SAS Server

Sample data on the SAS Server

The SAS Server includes various SAS libraries (and their corresponding SAS data sets).
As an instructor, you might want to use one or more of the SAS data sets from
SASHELP, MAPS or other SAS-provided libraries to ensure that all your students have
access to the data. To access sample data sets on the SAS Server:

1 Start SAS OnDemand for Academics: Enterprise Miner.
2 Create a new project or open an existing project.

3 In the tree on the left, right-click on Data Source and then select Create Data
Source.

4 The Source drop down box defaults to SAS Table. Click Next to accept the
default value and move to the next step in the wizard.

Next to the Table field (which will be blank), click Browse.
Use the Library drop down to select the appropriate library.

Select the SAS data set that you want to use and then continue with the wizard.

SAS data sets from the SAS Enterprise Miner courses

Additionally, SAS OnDemand for Academics stores SAS data sets associated with the
teaching materials from SAS Enterprise Miner courses on the SAS Server. To view
these:

1 Start SAS OnDemand for Academics: Enterprise Miner.
2 Create a new project or open an existing project.

3 In the tree on the left, right-click on Data Source and then select Create Data
Source.

4 From the Source drop down, select Metadata Repository and then click Next.
5 Next to the Table field, click Browse.

6 Use the Library drop down to select the appropriate library.

7

Select the SAS data set that you want to use and then continue with the wizard.

Custom course data on the SAS Server

Instructors have the option of uploading data files customized specifically for their
course to hosted SAS Servers. Detailed instructions are provided in this section for
uploading SAS data sets, other data files, and other SAS files types.
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Requesting assistance with custom course data on the SAS Server

While storing custom course data on the SAS Server is available to all instructors, the
process does require some familiarity with File Transfer Protocol (FTP) applications and
a knowledge of working with SAS filenames. SAS OnDemand for Academics provides
detailed instructions as well as hands-on support.

SAS is available to assist instructors who would like help with uploading their own data
for use within their courses. To request assistance, please send e-mail to
support@sas.com.

SAS will contact you as soon as possible. It might take up to three business days to
upload your data. In your e-mail, please include the following information:
O Name
College or University
Course Name
Phone Number
Software application being used (for example, SAS Enterprise Guide)
Type of data files that you would like to upload

[ S S Ny

Requirements for storing custom course data on the SAS Server

The SAS Server for is Unix-based. You should be aware of naming conventions and how
SAS OnDemand for Academics may handle files names. There are additional
requirements if your course makes use of third-party data.

File names and types

Please note the following requirements for filenames and types:

O Only data files may be stored on the SAS Server (no program files, course notes,
slides, and so on).

O Avoid using this space to store data files from individual students. This space is
intended to store the data files that an instructor wants all students to be able to
access to complete a course.

O Ensure that your data files are named using all lowercase letters. If you use mixed
or uppercase letters, then our hosted servers (which use Unix) might not detect
the files. For example, mydata.sas7bdat is an acceptable name, but
MyData.sas7bdat is unacceptable. By default, our system will automatically
change the name of your uploaded files to lowercase to avoid any issues.

O Avoid using spaces in data file names. For example, mydata.sas7bdat is an
acceptable name, but my data.sas7bdat is unacceptable. By default, our system
will automatically replace spaces with underscores to avoid any issues.

O Avoid using special characters (such as parentheses or ampersands) in data file
names.

O You should keep a master copy of your data files in another location.

O Instructors can store SAS data sets (file type extension of .sas7bdat) as well as
SAS data set index files (file type extension of .sas7bndx) on the SAS Server.
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Third party data sources

Some universities purchase third party data sources or use open source third party data
sources. Often, these data sources are protected by specific license agreements or terms
of use. Please review the license agreement or terms of use for the third party data
sources in question prior to uploading this type of data to the SAS Server. It is your
responsibility to:
O ensure that you have the right to upload third party data sources to the SAS
Server

O verify that use of the third party data sources does not violate any third party
rights or any applicable laws or regulations.

Uploading course files to the SAS Server

Please follow the instructions in this section for uploading SAS data sets, other SAS
files, and data files that are not SAS data sets onto the SAS Server.

Uploading SAS data sets for your course

To upload a SAS data set to the storage area for your course, you will need to work with
a File Transfer Protocol (FTP) application. If you are unfamiliar with the process, SAS
has provided step-by-step instructions with screen captures.

You are encouraged to print a copy of “SAS OnDemand for Academics: Storing and
Accessing SAS Data Files on the SAS Server, Instructor Guide” at
http://support.sas.com/ondemand/pdf/StoringandAccessingSASFiles.pdf.

Uploading other data formats on the SAS Server

Some SAS software applications, such as SAS OnDemand for Academics: Enterprise
Guide, are designed to use data other than SAS data sets. The following types of data
files can be stored on the SAS Server:

.asc (text file)

.csv (comma delimited)
.dat (flat data file)

.db (Paradox)

.dbf ({BASE)

.mdb (MS Access)

.tab (text file)

txt (text file)

.wk? (Lotus 123)

O
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To upload other data formats to the storage area for your course, you will need to work
with a File Transfer Protocol (FTP) application. If you are unfamiliar with the process,
SAS has provided step-by-step instructions with screen captures.

You are encouraged to print a copy of “SAS OnDemand for Academics: Storing and
Accessing Non SAS Files on the SAS Server” at
http://support.sas.com/ondemand/pdf/StoringandAccessingNonSASFiles.pdf.
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Encountering permission denied errors while using FTP

Your FTP client must be in passive mode to work properly. This is the default mode for
most FTP clients. If you access a “permission denied” error while trying to use FTP, then
your FTP client might not be in passive mode. Refer to the online help for your FTP
client to determine how to set passive mode.

Note: If you use the Microsoft Windows Command Line as your FTP client, then you
will likely have to turn passive mode on. To do so, enter the following command after
you have logged on to an FTP site:

literal pasv

Uploading and using directories

You can upload directories to the SAS Server using your FTP client. This might be
useful if you are trying to organize data files for specific purposes, such as grouping the
data used in different course assignments.

If you upload directories to the SAS Server, then the predefined LIBNAME and
FILENAME statements provided for your course will have to be modified to include the
directory name.

For example, if you create and upload a directory called examples, then the name of
this directory would have to be appended to the LIBNAME or FILENAME statement
generated for your course.

If your original course LIBNAME statement had this format:

libname mydata "/courses/u xxxx/i xxxxx/c xxx/saslib" access=readonly;

Your appended course LIBNAME statement would have this format (assuming that the
subdirectory examples was uploaded under the /saslib directory):

libname mydata "/courses/u xxxx/i xxxxx/c xxx/saslib/examples"
access=readonly;

Note: Directory names (as well as LIBNAME and FILENAME statements) are case-
sensitive. If you create and upload a directory named Examples, then you must append

Examples (and not examples or EXAMPLES) to your LIBNAME or FILENAME
statement.

Storing SAS catalog files on the SAS Server

Instructors can store SAS catalog files (file type extension of .sas7bcat or .sas7scat) on
the SAS Server and then use them as needed. Since the SAS Server is Unix based,
there are some unique steps that must be followed to use SAS catalog files. Additionally,
you must have access to a local copy of SAS software in order to complete the steps.

The following steps provide an example of how you could create custom formats and a
custom catalog and then upload and use them within SAS OnDemand for Academics.

1 Create custom formats and then store them in a local directory on your
PC. You must complete this step using a local installation of SAS software
instead of SAS OnDemand for Academics software.
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The following sample code creates a custom format and stores a SAS catalog on
your local PC. You can copy and paste the code to try it out (the
C:\TEMPFORMATS directory is used as an example, but could be replaced with a
different directory name):

libname mydata 'C:\TEMPFORMATS';

proc format lib=work;
value custom format

0="'30"
1='31"
2="32"
run;

proc catalog cat=work.formats;

copy out=mydata.formats;

run;

contents cat=mydata.formats;

quit;

filename tranfile 'C:\TEMPFORMATS\transport.dat';
proc cport catalog=mydata.formats file=tranfile;
run;

2 Create a transport file from the SAS catalog that now exists on your PC.
If you have a pre-existing SAS catalog with SAS formats, then you can also use
this step to create a transport file. Use the sample code below to create the
transport file. You can copy and paste the code to try it out:
libname mydata 'C:\TEMPFORMATS';
filename tranfile 'C:\TEMPFORMATS\transport.dat';

proc cport catalog=mydata.formats file=tranfile;
run;

3 FTP the transport.dat file in to your SAS OnDemand for Academics course
directory. Use the procedures found in Storing Other Data Formats on the SAS
Server.

4 Log on to SASOnDemand for Academics: Enterprise Guide. Open a Program
Editor window and then run the following code. You can copy and paste the code if
you wish to try it:
libname mydata "/courses/u x/i xxxxxx/c xxx/saslib";
filename trans2 '/courses/u x/i xxxxx/c_xxx/transport.dat';

proc cimport catalog=mydata.formats infile=trans2;
run;

Note: In the code above, replace the x characters with the numbers that
correspond to your university, instructor, and course numbers. For more
information, see Accessing Data Stored on the SAS Server.

5 Use your custom formats. The formats will persist over multiple sessions. Be
sure to use the FMTSEARCH option when you reference a format. See the
following code example. You can copy and paste the code if you wish to try it:
data myformat;
input a;

cards;
0
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runy;
options fmtsearch=(mydata);
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proc print data=myformat; format a custom format.;
run;

Note: The Code presented above is intended to be used solely as part of a product
(“Software”) you currently have licensed from SAS Institute Inc. or one of its
subsidiaries or authorized agents (“SAS”). The Code is designed to either correct an
error in the Software or to add functionality to the Software, but has not necessarily
been tested. Accordingly, SAS makes no representation or warranty that the Code will
operate error-free. SAS is under no obligation to maintain or support the Code.

Neither SAS nor its licensors shall be liable to you or any third party for any general,
special, direct, indirect, consequential, incidental or other damages whatsoever arising
out of or related to your use or inability to use the Code, even if SAS has been advised of
the possibility of such damages.

Except as otherwise provided above, the Code is governed by the same agreement that
governs the Software. If you do not have an existing agreement with SAS governing the
Software, you may not use the Code.

Accessing uploaded course data on the SAS Server

The following are instructions for accessing your custom course data once it has been
uploaded.

Assigning a SAS library to a project

To assign a SAS library to a project, use one of the following methods:
0 Use project start code.

0 Use the Program Editor window to assign a LIBNAME statement. You can access
the Program Editor by selecting View » Program Editor from within SAS
OnDemand for Academics: Enterprise Miner.

Using project start code

SAS OnDemand for Academics: Enterprise Miner enables you to include Start Code for
your projects. After you have specified this code, it will be run any time that the project
is started and can save you time and effort. For example, you might want to assign a
LIBNAME statement through Start Code so that a project can always access specific
SAS data sets.

To use project Start Code with a new project:
Start SAS OnDemand for Academics: Enterprise Miner.

2 Select New Project. From the New Project wizard, select a name for your project,
select the default values on the remaining wizard screens, and then select Finish.

3 From the Property tree on the left, locate the Project Start Code property.
4 Click the ellipsis ... button.
5 Enter the appropriate Start Code and then click either Run Now or OK.

Note: If you want to use project Start Code to access SAS data sets that use a format
file, then you must also specify the FMTSEARCH option in your start code. For more
information on this option, search for FMTSEARCH in the SAS 9.1.3 Online
Documentation at http://support.sas.com/documentation.
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To use project Start Code with an existing project:
Start SAS OnDemand for Academics: Enterprise Miner.
Open the appropriate project.

Click the ellipsis ... button.

1

2

3 From the Property tree on the left, locate the Property Code property.

4

5 Enter the appropriate Start Code and then click either Run Now or OK.

Note: If you want to use project Start Code to access SAS data sets that use a format
file, then you must also specify the FMTSEARCH option in your start code. For more
information on this option, search for FMTSEARCH in the SAS 9.1.3 Online
Documentation at http://support.sas.com/documentation.

Listing SAS data sets stored on the SAS Server

If you have uploaded SAS data sets to the SAS Server for a specific course and you want
to see the names and information associated with those SAS data sets, do the following:

1 Identify the LIBNAME statement associated with the course for which you have
uploaded data.

Start a SAS OnDemand for Academics: Enterprise Miner.
Open a Program Editor window from within the application.

Enter and run code similar to the example below. Replace the LIBNAME
statement in the example with the LIBNAME statement that you identified in
Step 1.
libname mydata "/courses/u_ xxxx/i xxxxx/c xxx/saslib" access=readonly;
proc contents data = mydata. all ;
run;

5 Use the Output window to review the results. The results will identify the SAS
data sets that you have uploaded.

Note: If you have created and uploaded a directory, then you must append the
directory name to the generated LIBNAME statement for your course.

Deleting SAS data sets stored on the SAS Server

If you are an instructor and you have uploaded data that you no longer want to make
available on the SAS Server (or you have exceeded your data storage quota), then you
can delete the data using the following steps:

1 Identify the location of your course data.
2 Use SAS Enterprise Miner to access the SAS Program Editor.

3 Do not append the access = readonly option to the LIBNAME statement when you
plan to delete files. If the LIBNAME statement is submitted as read-only, then
you will be unable to delete the files.

4 Use the DELETE statement within DATASETS procedure to specify the files
you’d like to remove from the SAS server.

Note: See online documentation for the DATASETS procedure in the Base SAS 9.2
Procedures Guide on http://support.sas.com/documentation. If you are unfamiliar with
the DATASETS procedure, you can open a SAS Technical Support request by sending e-
mail to support@sas.com. In your request, please specify your course as well as the
data that you would like to have deleted from the SAS Server.
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Step 5. Review and test course materials

Instructors may choose to use course materials provided by SAS provides course
materials, or they may choose to refer to course materials from previous SAS courses.

Importance of reviewing the software

In some cases, the steps needed to complete certain tasks might be different when using
SAS OnDemand for Academics software applications (versus traditional SAS software
applications). By reviewing and testing your course materials prior to class, you can
prepare yourself and your students for any minor differences.

Note: While it might take 30 minutes or less to review available course information
and test the information against SAS OnDemand for Academics, you might have to
register for and/or request course materials from SAS (if applicable). This process could
take a few days. Please plan accordingly.

There are a few differences between traditional SAS Enterprise Miner Version 6.2 and
SAS OnDemand for Academics: Enterprise Miner Version 6.2:
O You must accept the default project storage location when creating new projects.
See “Creating New Projects.”
O Your projects are stored within the My Folder folder. See “Opening Existing
Projects” for more information.
O Certain nodes are unavailable, might not function properly, or are experimental.
For example, the File Import node is unavailable.
O SAS Text Miner 4.2 nodes are available, but are considered experimental. See
SAS Text Miner 4.2 documentation at
http://support.sas.com/documentation/onlinedoc/txtminer/ for more information.

Teaching materials provided by SAS

Instructors may choose to use training materials provided by SAS, or they may choose to
refer to course materials from previous SAS courses.

SAS Education provides certain teaching materials free of charge to instructors at
degree-granting academic institutions. These materials include an electronic copy of
course notes, slides, and in some cases, code and data. The materials are not available
for use by students. Visit Teaching materials from SAS at the Training & Bookstore for
SAS Global Academic Program at http://support.sas.com/learn.

Note: Prior to downloading the course materials, an instructor must register for
SAS OnDemand for Academics. Additionally, instructors will be required to accept a
license agreement that specifies the terms and conditions of usage.

The training materials were developed for users who are running SAS locally. Certain
SAS code examples might not work or might need to be modified for use with

SAS OnDemand for Academics. For example, any referenced SAS data sets would need
to be uploaded to the SAS Server and any LIBNAME statements would have to be
modified to reflect the LIBNAME statement for an instructor's SAS OnDemand for
Academics course.
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Accessing teaching material and data for SAS Enterprise Miner

In some cases, we have already uploaded the SAS data sets used by popular teaching
materials. To use SAS data sets associated with the teaching materials from specific
SAS Enterprise Miner courses, do the following:

Start SAS OnDemand for Academics: Enterprise Miner.

Create a new project or open an existing project.
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In the tree on the left, right-click on Data Source and then select Create Data
Source.

4 From the Source drop down, select Metadata Repository and then click Next.
5 Next to the Table field, click Browse.

6 Use the Library drop down to select the appropriate library.

7 Select the SAS data set that you want to use and then continue with the wizard.

Alternatively, assign one or more of the following LIBNAME statements using SAS
Enterprise Miner project start-up code:

O libname aaem “/tutorials/em/data/aaem”;

libname aaemspel “/tutorials/em/data/aaem_spel”;

libname air “/tutorials/em/data/air”;

libname dmdt5 “/tutorials/em/data/dmdt53”;

libname Iwemi “/tutorials/em/data/lwemi”;

libname Iwemi2 “/tutorials/em/data/lwemi/Instructor_only”;
libname pmadv “/tutorials/em/data/pmad53”;

Note: The LIBNAME aaemspel is compatible with SAS Enterprise Miner 5.2 and for
use with the SAS Enterprise Miner Self Paced E-Learning course.

Ry I I Ry

Practice exercises, statistics information, and sample SAS data sets

For instructions about how to perform all of the basic statistics taught in an
introductory statistics class, libraries of SAS data sets, and a library of practice
exercises, visit the SAS Online Resources for Statistics Education Web site on
http://support.sas.com/learn/statlibrary.

Books, training, and other reference materials

SAS Publications are available online at http:/support.sas.com/publishing. You can find
books, review portions of each book, and place orders.

SAS Publishing offers products to qualified college faculty who are interested in
teaching SAS. For more information, see the Academic Evaluation Copy Program.

Other publications are available for download from the SAS OnDemand for Academics
Web site on http:/support.sas.com/ondemand .
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Step 6. Share course information with students

After you create your course, prepare your data, and become familiar with the software,
you should:

O invite your students to register for your SAS OnDemand for Academics course
O provide important information on how to access the course software and data.
We recommend that you ask your students to complete these steps prior to the

beginning of your course (if possible) or during the first week of your course. Some
instructors choose to use the first class of a course to review how to perform these steps.

Ask students to register for SAS OnDemand for Academics

When you create a course within SAS OnDemand for Academics, you are presented with
text that you can copy and paste in to an e-mail to send to your students. This text
provides the information that your students will need to register for SAS OnDemand for
Academics and download the appropriate software application.

If you don't copy and paste the text when you initially create a course, you can access
the information again at any time:

1 Log on to your SAS OnDemand for Academics Home Page.

2 Under the Manage Courses area, click the Info link next to the appropriate
course.

3 Select View a sample message.

A generic version of the e-mail text is provided below as an example. You can copy,
paste, and customize this text if needed. For example, if you have a coupon code that
students need to use, you can include that code in your e-mail.

Dear student:

I plan to use SAS OnDemand for Academics: Software Application Name software to teach course
name.

As a student in my class, you will need to register for SAS OnDemand for Academics and then
access SAS OnDemand for Academics. Software Application Name.

Here's how to get started:

1. Access the SAS OnDemand for Academics Control Center at the following URL:
http://support.sas.com/ctx3/sodareg/index.html

2. Review the information and follow the steps at this site.

3. If you have additional questions, review the information about using SAS OnDemand for Academics at
http://support.sas.com/ondemand or contact me.

Thank you.
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Provide students with information about the system

While it is up to you to determine how you want to invite your students to participate,
we recommend that you send e-mail to the students on your course roster. In the e-mail,
it might be useful to:

O highlight system requirements, especially if you think the requirements could be
an issue for some students. Please note that the SAS OnDemand for Academics
products are not supported on Macintosh computers.

O include step-by-step installation instructions.

Suggested information to share with students

How to register for SAS OnDemand for Academics. A printable, step-by-step guide
“SAS OnDemand for Academics: Enterprise Miner, Student Registration Instructions” is
available from http:/www.sas.com/govedu/edu/programs/enterprise_miner_student.pdf.

As an instructor, you might want to share copies of the guide or links to the appropriate
guide with your students.

How to access course data on the SAS Server. If you choose to store data on the
SAS Server, then you must share the LIBNAME statement associated with that data
with your students. For example, you might include the information in course notes or
through e-mail.

How to start SAS Enterprise Miner. After registering for SAS OnDemand for
Academics, students just click a link from their SAS OnDemand for Academics Home
Page to start SAS Enterprise Miner.

Step 7. Review the basics for working with data, results, and projects

During the first week of class, we recommend that you review with your students the
basics of working with SAS data sets, models, and results in SAS OnDemand for
Academics: Enterprise Miner.

Working with data

To ensure that students can access course data and that they do not lose their work,
you should cover the basics of accessing and using data from the SAS Server.

SAS OnDemand for Academics: Enterprise Miner uses the SEMMA project model to
organize work and options for accessing data are specific to this product.

Before you access the appropriate data sets for your exercises, you must assign a
SAS library to your projects using one of the following methods using a project using
Start Code or submitting a LIBNAME statement.

Assigning a SAS Library to a project using Start Code

SAS OnDemand for Academics: Enterprise Miner enables you to include Start Code for
your projects. After you have specified this code, it will be run any time that the project
is started and can save you time and effort. For example, you might want to assign a
LIBNAME statement through Start Code so that a project can always access specific
SAS data sets.
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Using Start Code with a new project:
1 Start SAS OnDemand for Academics: Enterprise Miner.

2 Select New Project. From the New Project wizard, select a name for your project,
select the default values on the remaining wizard screens, and then select Finish.

3 From the Property tree on the left, locate the Project Start Code property.
4 Click the ellipsis ... button.
5 Enter the appropriate Start Code and then click either Run Now or OK.

Note: If you want to use project Start Code to access SAS data sets that use a format
file, then you must also specify the FMTSEARCH option in your start code.
Using Start Code with an existing project:

1 Start SAS OnDemand for Academics: Enterprise Miner.

2 Open the appropriate project.

3 From the Property tree on the left, locate the Property Code property.

4 Click the ellipsis ... button.

5 Enter the appropriate Start Code and then click either Run Now or OK.

Note: If you want to use project Start Code to access SAS data sets that use a format
file, then you must also specify the FMTSEARCH option in your start-up code.

Assigning a SAS Library using LIBNAME statements

You can access the Program Editor by selecting View » Program Editor from within
SAS OnDemand for Academics: Enterprise Miner.

Instructors have the ability to store SAS data sets on the SAS Server. If your instructor
has taken advantage of this feature, then you must use the appropriate LIBNAME
statement for your course to access that data. You must also share this LIBNAME
statement with your students for them to access the data. The LIBNAME value for the
course will be assigned when you register the course. To find the LIBNAME value,
select the Info link next to the corresponding course listed on your SAS OnDemand for
Academics Home Page.

Note: LIBNAME statements are case-sensitive. Please copy them or type them in
exactly as they appear to avoid permissions errors.

Accessing data using SAS OnDemand for Academics: Enterprise Miner

The SAS Server includes various SAS libraries (and their corresponding SAS data sets).
As an instructor, you might want to use one or more of the SAS data sets from
SASHELP, MAPS or other SAS-provided libraries to ensure that all your students have
access to the data. To access sample data sets on the SAS Server:

1 Start SAS OnDemand for Academics: Enterprise Miner.
2 Create a new project or open an existing project.

3 In the tree on the left, right-click on Data Source and then select Create Data
Source.

4 The Source drop down box defaults to SAS Table. Click Next to accept the
default value and move to the next step in the wizard.

5 Next to the Table field (which will be blank), click Browse.
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6 Use the Library drop down to select the appropriate library.
7 Select the SAS data set that you want to use and then continue with the wizard.

Accessing SAS Enterprise Miner course data on the SAS Server

Additionally, SAS OnDemand for Academics stores SAS data sets associated with the
teaching materials from SAS Enterprise Miner courses on the SAS Server. To view
these:

1 Start SAS OnDemand for Academics: Enterprise Miner.
2 Create a new project or open an existing project.

3 In the tree on the left, right-click on Data Source and then select Create Data
Source.

From the Source drop down, select Metadata Repository and then click Next.
Next to the Table field, click Browse.
Use the Library drop down to select the appropriate library.
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Select the SAS data set that you want to use and then continue with the wizard or
data files to the SAS Server for use in specific courses.

Accessing grayed-out SAS libraries from the SAS Server

The SAS Server includes sample SAS data sets that you might choose to use. Some of
the sample SAS Libraries might appear to be grayed out, but they are still available for
use.

Typically, grayed out SAS Libraries appear for users in Europe and were originally
intended for use with SAS Enterprise Miner.

1 Start SAS OnDemand for Academics: Enterprise Miner and log on.
Select File » Open » Data.

Select Servers.

Double click on SAS Apps.

Double click on Libraries.
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Right click on the grayed out SAS Library that you would like to access and then
click Assign.

7 Double click on the SAS data set that you want to use.

Working with projects

SAS OnDemand for Academics: Enterprise Miner uses the SEMMA model to organize
data mining projects. SAS recommends that you share the following information with
your students so they can use the interface most effectively.

Understanding Project Storage Quotas

Each SAS OnDemand for Academics: Enterprise Miner user has a large project storage
quota. An e-mail message is sent to any user who has used 75% of their storage quota.

If the project storage quota is reached, then SAS OnDemand for Academics: Enterprise
Miner will stop functioning properly. To avoid this, consider deleting any unnecessary
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projects prior to reaching your quota to ensure that SAS OnDemand for Academics:
Enterprise Miner continues to work properly.

If you do reach your quota and then delete unnecessary projects to create more project
storage space, then the last project that you were working with could be impacted. If the
project runs incorrectly after removing unnecessary projects, then you might need to
rebuild the diagrams for this project.

Creating New Projects

When you create a new project, you will use the Create New Project wizard. Step
Three of this wizard enables you to select a SAS folder in which to store your project.
Even though you have the ability to browse in this step, please accept the default project
storage location:

/Users/your-user-id/My Folder

Accepting the default project storage location will ensure that your projects can be
accessed appropriately by SAS OnDemand for Academics servers.

If you select Browse and attempt to store your project in a location other than the
default, the following error will result:

eror x|

Exception occurred updating the 5435 Metadata
Repositary.

To correct this error, change the location where your project will be stored back to the
default location: /Users/your-user-id/My Folder

Opening Existing Projects

To find and open an existing project, perform the following steps:
Start SAS OnDemand for Academics: Enterprise Miner.
Click Open Project.

From the Open Project window, open the My Folder folder.

Select the project that you want to open.
Click OK.
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Creating model packages

With SAS OnDemand for Academics: Enterprise Miner, users can create model packages
(also known as SAS Package Files or .spk files). Model packages can be created from any
node in a diagram. Typically, you create a model package when you are satisfied with
your model and you want to preserve it or share it with someone else.

In most cases, you create the model package from the last node of a process in a
diagram. This ensures that the model package will include the entire process flow.
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Differences hetween project model packages and exported project diagrams

With SAS OnDemand for Academics: Enterprise Miner, a user can create a model
package and send it as a SAS Package File (.spk), or export a diagram as an XML file
(.xml). If a specific project takes a long time to run, having the model package (with the
associated results) can be advantageous.

Exported diagrams contain no results. After a project's diagram has been exported as an
XML file, it can be shared as an attachment in an e-mail message or by placing the file
on a shared network directory. To use the shared file, it must be imported in to

SAS OnDemand for Academics: Enterprise Miner and then the appropriate path of the
diagram would have to be run to produce results.

Note that neither model packages nor exported diagrams include the actual data that is
referenced. To rerun the project, you must have access to the original data or use the
LIBNAME statement that points to the original data if that data is stored on the

SAS Server.

Sharing homework assignments

There are three ways that you can share homework assignments: either by creating and
registering a project model package, by sharing a project model package, or by sharing a
project diagram. As an instructor, you will want to review these methods, decide which
method aligns with course objectives, and be able to answer any questions your students
may have about the process.

Submitting homework assignments

With SAS OnDemand for Academics: Enterprise Miner, students can create and submit
an entire project model package, or export a project diagram and share the exported file.

Ultimately, the choice is up to the instructor. The decision might be made based on
whether or not the instructor needs access to project results or diagram files.

To submit a project model package to an instructor:

1 Create a project or open an existing project within SAS OnDemand for Academics:
Enterprise Miner.

Highlight the appropriate node within a diagram.
Select Actions --> Create Model Package.

In the Input dialog box, enter a name for the model package. To ensure that you
choose a unique file name, you might want to include your name or initials as part
of the file name. This will ensure that an instructor can distinguish one submitted
model package from another.

5 From the Project Panel on the left side of SAS OnDemand for Academics:
Enterprise Miner, expand the Model Packages folder.

6 Right click on the appropriate model and then click Save As. You will be
prompted to save the model as a SAS Package File (.spk).

7 Share the appropriate .spk file with your instructor (through e-mail or through a
shared network directory).

To submit an exported project diagram to an instructor:

1 Create a project or open an existing project within SAS OnDemand for Academics:
Enterprise Miner. Ensure that your project includes a diagram.
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2 From the Project Panel on the left side of SAS OnDemand for Academics:
Enterprise Miner, expand the Diagrams folder.

3 Right click on the appropriate diagram and then select Save As. Save the diagram
as a . XML file. To ensure that you choose a unique file name, you might want to
include your name or initials as part of the file name. This will ensure that an
instructor can distinguish one submitted diagram from another.

4 Share the XML file with your instructor (through e-mail or through a shared
network directory).

Accessing submitted homework assignments

After students have submitted homework assignments, instructors can access them. The
access method is dependent on how the homework was submitted.

To use a project model package file that a student has shared:
1 Open SAS OnDemand for Academics: Enterprise Miner.
2 Select File » Open Model Package.
3 Navigate to the location where the student's model package has been saved and

select it.

Note: You will be unable to make any changes or rerun the diagram nodes. However,
you can choose Action » Recreate Diagram to recreate a diagram within the current
project. Once a diagram is recreated, you will have a working copy of the diagram, just
as if you imported the appropriate diagram.xml. You must run a diagram path to
produce any results.

To use a project diagram file that a student has shared:

1 Open SAS OnDemand for Academics: Enterprise Miner.

2 Create a new project or open an existing project.

3 Select File » Import Diagram from XML.
4

Import the diagram XML file from the student.

Collahorating

Students can collaborate with each other while using SAS OnDemand for Academics:
Enterprise Miner in one of two ways:

O by saving an entire project as a model package and then sharing the model
package

O by exporting project diagrams as XML files and then sharing those files with each
other.

The choice might be determined by whether or not the students need to share the
results of a project. Exported diagrams do not contain results while model packages do.

Note: Neither model packages nor exported diagrams include the actual data that is
referenced. To rerun the project, you must have access to the original data or have the
LIBNAME that points to the original data if that data is stored on the SAS Server.

To share a project model package:

1 Create a project or open an existing project within SAS OnDemand for Academics:
Enterprise Miner.

2 Highlight the appropriate node within a diagram.
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Select Actions P Create Model Package.

In the Input dialog box, enter a name for the model package. To ensure that you
choose a unique file name, you might want to include your name or initials as part
of the file name. This will ensure that your peers can distinguish one model
package from another.

From the Project Panel on the left side of SAS OnDemand for Academics:
Enterprise Miner, expand the Model Packages folder.

Right click on the appropriate model package and then select Save As. Save the
model package as an .spk file.

Share the .spk file as needed (through e-mail or through a shared network
directory).

Note: The user who receives the model package can start SAS OnDemand for
Academics: Enterprise Miner and choose File » Open Model Package to open the
package and view the diagram and results. The user will be unable to make any changes
or rerun the diagram nodes. However, the user can choose Action » Recreate
Diagram to recreate the diagram within the current project. Once the diagram is
recreated, the user will have a working copy of the diagram, just as if they imported the
appropriate diagram.xml. The user must run a diagram path to produce any results.

To share a project diagram:

1

Create a project or open an existing project within SAS OnDemand for Academics:
Enterprise Miner. Ensure that your project includes a diagram.

From the Project Panel on the left side of SAS OnDemand for Academics:
Enterprise Miner, expand the Diagrams folder.

Right click on the appropriate diagram and then select Save As. Save the diagram
as a .XML file. To ensure that you choose a unique file name, you might want to
include your name or initials as part of the file name. This will ensure that your
peers can distinguish one diagram from another.

Share the XML file as needed (through e-mail or through a shared network
directory).

To use a shared project diagram:

1
2
3
4

Start SAS OnDemand for Academics: Enterprise Miner.
Create a new project or open an existing project.

Select File » Import Diagram from XML.

Import the appropriate diagram XML file.

Step 8. Finding Help for Common Problems

Please check the commonly asked questions about SAS OnDemand for Academics:
Enterprise Miner in this section and follow the procedures below for additional help.
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Where can instructors find help?
Please follow the steps below to resolve any technical issues.

Step 1: Review Commonly Asked Questions, SAS Notes, and SAS
Documentation

Use the key word ‘ondemand academics’ to search for issues specific to SAS OnDemand
for Academics from these sources:
0 Commonly Asked Questions about SAS OnDemand for Academics in this manual

O SAS Notes, a database of common technical issues found on
http://support.sas.com/notes

O SAS Product Documentation on http:/support.sas.com/documentation
Step 2: Contact Your SAS Site Representative (if applicable)

If you are an instructor at a university that already uses SAS Software, then you might
have a SAS Site Representative who can provide SAS support.

If you are unsure about whether you have a SAS Site Representative, contact the person
or department that supports your university's software purchases and installation.

Step 3: Contact SAS Technical Support (Instructors)

SAS Technical Support is designed to assist you with technical issues such as
installation or setup questions. They are not available for providing training or
answering basic usage questions.

If the above steps have not resolved your issue, please contact SAS Technical Support:

1 Open the SAS Technical Support Problem Form found on
http://support.sas.com/techsup/.

2 Fill out and submit the form. When filling out the form, use the following values:
0 For Company Name, enter SAS OnDemand for Academics.
Q For Site Number, enter 00700315

Optionally, e-mail your support request to support@sas.com. Be sure to specify that
you are using SAS OnDemand for Academics.

Where can students find help

Students should be asked to follow the steps below to resolve any support issues they
encounter:

Step One: Review Commonly Asked Questions, SAS Notes, and SAS
Documentation

Use the key word 'ondemand academics' to search for issues specific to SAS OnDemand
for Academics from these sources:

O Commonly Asked Questions about SAS OnDemand for Academics in this manual

O SAS Notes, a database of common technical issues found on
http://support.sas.com/notes

O SAS Product Documentation on http://support.sas.com/documentation
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Step Two: Contact Your Instructor

If you are a student and you have questions about using SAS OnDemand for Academics,
contact your instructor. Instructors can point students toward educational resources and
help ensure that offerings are used correctly.

If further assistance is needed, then your instructor can contact SAS Technical Support.

Commonly Asked Questions: SASOnDemand for Academics: Enterprise
Miner

0 Does SAS OnDemand for Academics: Enterprise Miner have all the same features
as SAS Enterprise Miner?
The version of SAS Enterprise Miner available through SAS OnDemand for
Academics does have a few differences.
O You must accept the default project storage location when creating new
projects.

Q Your projects are stored within the My Folder folder.

Q Certain nodes are unavailable, might not function properly, or are
experimental. For example, the File Import node is unavailable.

O SAS Text Miner 4.2 nodes are available, but are considered experimental.

0 Can I use SAS OnDemand for Academics: Enterprise Miner if I already have SAS
Enterprise Miner on my PC?

Yes. SAS OnDemand for Academics: Enterprise Miner is mutually exclusive from
any other version of SAS Enterprise Miner and should not cause any conflicts or
reset any file type associations.
Please note that the projects that you create with each version of SAS Enterprise
Miner are also mutually exclusive. If necessary, you can save a project diagram
xml file created in one version of SAS Enterprise Miner and import it in to another
version. However, for this to work, you must have access to the necessary data on
the appropriate PC as well.

O How do I configure my PC to use SAS OnDemand for Academics: Enterprise
Miner?
In order to use SAS OnDemand for Academics: Enterprise Miner, you must first
ensure that your PC is properly configured. It is especially important that the
appropriate version of the Java Runtime Environment is installed on your
machine. Refer to “Verify and install Java Runtime Environment (JRE)” for SAS
OnDemand for Academics: Enterprise Miner.

O How do I start SAS OnDemand for Academics: Enterprise Miner?

After you have configured your system to support SAS OnDemand for Academics:
Enterprise Miner, you can start the application by following these steps:

1 Log on to your SAS OnDemand for Academics Home page.

2 From the Manage Courses area, select Get Software next to the
appropriate course. Selecting this link will open a window that includes
information about how to configure your system as well as how to start the
application.

3 Click the link that is used to start SAS OnDemand for Academics: Enterprise
Miner (http://emcloud.oda.sas.com:16098/EnterpriseMiner/main.jnlp).
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4 Ifyou are presented with a security warning such as the following, select Run.

Warning - Security B

X
The application's digital signature has an error. Do you '
want to run the application? i

Hame: SAS Enterprize Miner 5.3
Publisher: SAS Institute Inc.

From: hittp: Memcloud oda.sas .com: 16093

Run Cancel

w The digital signatura was ganerated with a trusted cerifizate but o
.

has expired.

5 In the User Name field, enter your SAS Server user ID. This user ID is also
displayed on your SAS OnDemand for Academics home page:

* Getting Started

A Your SAS Server userid it sas.instructor

Use this userid when you log on w e SAS Server.

» Register a course:
Registering a course will make it available to your students.

To edit course information or review helpful details about courses, click on the course titie. To obtain the software for a course
select the link in the Download column.

Note: Your SAS Server user ID is case sensitive and should be entered in all
lowercase. If you enter your SAS Server user ID using uppercase or mixed case
letters, you might be able to log on, but certain tasks might not perform
properly.

6 In the Password field, enter your SAS Profile password. There are two times
when you might have supplied a SAS Profile password: either when you

originally created a SAS Profile or when you registered for SAS OnDemand for
Academics.

7 Click Log On.

To start SAS OnDemand for Academics: Enterprise Miner in the future, you can perform
the previous steps or simply use the following URL:
http://emcloud.oda.sas.com:16098/EnterpriseMiner/main.jnlp.

O Ireceive the following error when trying to log on to SAS OnDemand for
Academics: Enterprise Miner: “An RMI registry could not be found... “. What
should I do?

This error message typically indicates that you did not complete some or all of the
configuration steps necessary. You should review or complete the configuration
steps and then try to log on again. You only have to complete the configuration
steps once in order to use SAS OnDemand for Academics: Enterprise Miner.

O Ireceive the following error when trying to log on to SAS OnDemand for
Academics: Enterprise Miner: “Could not log on. Contact your administrator for
the correct username and password.” What should I do?
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If Microsoft Windows Vista prompted you to block javaw.exe when attempting to
start SAS OnDemand for Academics: Enterprise Miner and you chose to block the
file, then this error message occurs.

To correct this situation, you must open Windows Firewall and unblock the
javaw.exe file. For example, on Microsoft Windows Vista Home Premium
Edition, the following steps might work:

Q Select Start » Control Panel » Windows Firewall.
Q Click the Change Settings link.

Q Select the Exceptions tab.

0 Find javaw.exe and make sure it is unchecked.

For more information, refer to Microsoft Windows Vista help or contact your
system administrator.

O Ireceive the following error when trying to log on to SAS OnDemand for
Academics: Enterprise Miner: "Network Error. The connection to the Analytics
Platform has been lost. This client session must be terminated." What should I do?

This error message typically occurs if you have left SAS OnDemand for
Academics: Enterprise Miner open, but have left it idle for a period of time. Close
SAS OnDemand for Academics: Enterprise Miner and restart it to try and resolve
the issue.

O I receive the following error in my SAS log when trying to use a SAS catalog file
that I have uploaded to the SAS Server: "ERROR: File LIBRARY
NAME.CATALOG NAME.CATALOG was created for a different operating
system." What is wrong?

This error message typically occurs if you have tried to use a SAS catalog file that
was created using an operating system other than Unix. To resolve the issue, refer
to “Storing SAS catalog Files on the SAS Server” for SAS OnDemand for
Academics: Enterprise Miner. This topic includes usage information and sample
code.

O How do I save my work in SAS OnDemand for Academics: Enterprise Miner?

There is no Save button in this application. Your project is automatically saved for
you while you work. When you are done working, select File --> Close this
Project to ensure that your project saves properly.

O How do I submit homework using SAS OnDemand for Academics: Enterprise
Miner?

There are three ways that you can share homework assignments: either by
creating and registering a project model package, by sharing a project model
package, or by sharing a project diagram. Your instructor will tell you the method
that he or she would like you to use.

O How do I collaborate using SAS OnDemand for Academics: Enterprise Miner?
You can collaborate by sharing an entire project model package or a project
diagram. For more information, see these topics: “Differences between Project
model packages and exported project diagrams” and “Collaborating” for SAS
OnDemand for Academics: Enterprise Miner.

0 Can I use a project model package or project diagram from older versions of SAS
Enterprise Miner?

Some project model packages and project diagrams created in older versions of
SAS Enterprise Miner work fine while others do not. If you try to use a project or
diagram created with an older version of SAS Enterprise Miner and the



SAS OnDemand for Academics: Enterprise Miner  Step 8. Finding Help for Common Problems 67

application becomes unresponsive, close the application and avoid using the
project model package or project diagram in the future.

O My project or diagram is unresponsive or no longer opens. What's wrong?

If you have lost a connection to the SAS Server while working on your project or

diagram or if you did not properly close SAS OnDemand for Academics: Enterprise

Miner, then a lock file might have been created. This lock file could cause your

diagram or project to appear unresponsive or it could prevent your diagram or

project from opening at all. Try the following to correct the issue:

O Ifthe lock has just happened, try waiting about five minutes. In many cases,
locked files correct themselves.

Q Ifyou are unsure of when the lock occurred or if it has been longer than five
minutes, close the project, log out of SAS OnDemand for Academics: Enterprise
Miner, and then log back in.

O If the problem persists, please contact SAS Technical Support. Send e-mail to
support@sas.com. Specify that you are using SAS OnDemand for Academics:
Enterprise Miner.

Notes:

O SAS recommends that you close your diagrams and/or projects before exiting
SAS OnDemand for Academics: Enterprise Miner or before disconnecting from
your Internet connection.

O An open connection to the SAS Server will likely disconnect (time out) after
one hour if the connection is idle (that is, you have not performed any
processing). Many firewalls disconnect open sessions after an hour of idle time,
and this could lead to locked files. SAS recommends that you complete your
work, save it, and then exit SAS OnDemand for Academics: Enterprise Miner
before you leave the computer.

QO When I open SAS OnDemand for Academics: Enterprise Miner, I no longer see my
projects. What is wrong?

This behavior can occur if you log on to SAS OnDemand for Academics: Enterprise

Miner using a mixed case or upper case SAS Server user ID. Please close SAS

OnDemand for Academics: Enterprise Miner and log on again. Make sure that you

use all lowercase letters for your SAS Server user ID.

O Can I create a SAS Library using SAS OnDemand for Academics: Enterprise

Miner?

No. However, you can work with available SAS Libraries or assign LIBNAME

statements.

0 Ihave been provided with a LIBNAME statement for my course. How do I assign
it?

If you have a LIBNAME statement for your course (either because you are an

instructor and you have uploaded data to the SAS Server or because you are a

student and your instructor has provided you with a LIBNAME statement to use),

you can assign it in one of two ways:

O Assign the LIBNAME statement as part of your project Start Code to ensure
that the SAS Library is available throughout your project; this LIBNAME
statement will also execute each time that you start your project.

Q Assign the LIBNAME statement within a project using the SAS OnDemand
for Academics: Enterprise Miner Program Editor window.
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0 I am using a SAS data set that requires a format file. How do I define the path to
the format file?
You can define a path to a format file using project Start Code.

O I either have or might reach my project storage quota. What do I do?
If you exceed your project storage space quota, then SAS OnDemand for
Academics: Enterprise Miner will stop processing nodes properly. To resolve this
situation, delete existing projects that you no longer need in order to free up
project storage space.
The last project that you created or were working with when you met your project
storage space quota could be impacted (even after you delete existing projects to
create more space). If such a project appears to run incorrectly, then you might
need to rebuild the diagrams for this project.



69
CHAPTER

SAS OnDemand for Academics:
Forecast Server (heta)

SAS On Demand for Academics: Forecast Server (Bet@) ..........cccccouvueieviiiiiniiiiiiniiieeesiieeeniieeesiteessiveeenns
Step 1. CONFITm SYSECIM TEQUITCIMEILES......veeeeeeveeeeeveeeeeieeeesiteeeeeisteeesseeeassreeesssseasassseesssssseesssseessssssesssssaeesns
Confirm requirements for fUll SUPPOTE............ccueeeeceieeeiieeeeiieeeeeeteeeeeteeeesreeessseeeessssesssssseeesssessssees
Verify network performance............cccccevvveeeenieiennieeesnneenn.
Verify and install a Java Runtime Environment (JRE)
Step One: Verify whether a JRE (and Java Web Start) is installed...............cccceevvvevveeeeneccnnnnnnn. 71
Step Two: Ensure that you are using only the recommended Java Runtime Environment........ 72
Step Three: Install the recommended Java Runtime Environment and Java Web Start........... 73
Step 2. Set up your SAS® OnDemand for ACQAeMICS QCCOUNE ...........c.eeeeeeeeeeeeseeeeeeeeeeeeeeeeeseeessees e
About the SAS OnDemand for Academics Control Center...
ADbOUL YOUT SAS Profile GCCOUNE......ecccuveeeeeiieeeeciiieeeeiieeesieeeeetteeeeiasaeessseeeessseesesssseeesssaeesssseeessssesesnnns
Important information Defore YOU BEGiTu............cccueeeecueeeeeiieeeeeieeeeeieeeesiseeeessreessssseessssseeesssseessssseeenns
About SAS Forecast Server environments
REGISLET @S QT ITLSETUCEOT ......vvveeeeeeeeeeiteeeeeeeeeetteeeeeeeeeetaaaaeeeeeaassssssaaeeaaaessssssaesesessansssaaaaeassennsraeeeens
ROGISTT (L COUTSC.c...eveeniieeeiiee ettt ettt et e e ettt e et e e s st e e e st e e e s st e e e s sbaeessbteesaabbeessabbeeesabbeeesnnreas
Step 3. Access and use the software
Access your SAS OnDemand for ACQdemics QACCOUNTE ..........cccueeeeeiueeeeeirieeeeiieeeecteeesereeessreeessseesssnes
Locate the name of your SAS Forecast Server enuirONmMeNE...........ccccueeecueeeniueeereieeeneieeessseeessseeesnns
Access SAS Forecast Server
ACCESS BRE SAS SCIUCK ......oeeeniiii ettt ettt ettt et e st e e st e e st e e s bae e e e bae e e saaeeesnabaeesane
SAS Server maintenance and QUAILABDILILY .............cccueieeeieieeeiiieeeeieeeecteeeeeveeeesaeeeesseeesssseeeessseeesnns
Requesting SAS Server availability notification
Step 4. Prepare COUTSE AQEQ . ..........cuceuuureeeeeieeeiiieeeeeeaeeeeivtteeeeaassisssteeeeasassssssreseesssssssssssesessssssssssseeessssssssnes
Step 5. Review and test Course MALeTIQLS..............coeeecceuueeeeeeieeeeiiiieeeeeeeeeitteeeeeeeesisssaeeeeeeesssssssesessesssssees
Importance of reviewing course materials
Teaching materials provided By SAS ..........cceiiiciie ettt e eeee e e sttt e e e taeeessaeeessbeeesssseeesnnseeeens
Books, training, and other reference MAeriQls ..........ccccoovcueeeiiieeiniiieeeiiieeeriteeeriteessiteeesireessareeeeas
Step 6. Share course information with students
Ask students to register for SAS OnDemand for Academics
Provide students with information QBOUE tRE SYSTEML ........c..eeeeeuveeeeiiieeecieeeecieeeesireeessareeesseeessareeenns
Suggested information to share with students
Step 7. Review the basics for working with data and reSULLS .............ccccevuveeieeeeieciiiiieeeeeeeciirireeeeeeeenaaees
ADOUEL PTOJECE SEOTQZE ......vvveeeeeeeeeiiieeeeeeeeecitteeeeeeeeetaateeeeaaesssssaeaaaeasasssssaseeaasassssssaseesesessssssaeeeeeseasnssees
Working with forecasting project results .
Step 8. Help for COmmomn Problems ............ccuieeccueieeeiiiieeeiieeeeiieeesiieeesiaeeessseesssseesssssseessssesessssesssssasesns
Where can instructors find REIP? .........cccueieicieieeciee et e e teeseateeestaeeeetaeeessseeessseeeesnsaeesnsseeeens 81
Step 1: Review Commonly Asked Questions, SAS Notes, and SAS Documentation
Step 2: Contact Your SAS Site Representative (if applicable) .............ccccovveeeiiiieeciiuveeeeeeeeecinnnnns
Step 3: Contact SAS Technical Support (INSEFUCLOTS) ......cccuveeeecieeeeiiieeeeiieeeeeieeeesvreeeeeveeeeeaeens
Where can students find help
Step One: Review Commonly Asked Questions, SAS Notes, and SAS Documentation............... 82
Step Two: Contact Your Instructor
Commonly Asked Questions for SAS OnDemand for Academics: Forecast Server ....
INOEES: ...eeeee ettt ettt e e e ettt e e e e e e ettt e e e e e e et taeee e e e e attaeeeeeeaaahtrateeeeeaaanrtaaaeaeseaannrraeaes 83




70 Step 1. Confirm system requirements

Chapter 4

SAS OnDemand for Academics: Forecast Server (beta)

This manual guides instructors through recommended steps for registering for SAS
OnDemand for Academics, preparing to teach courses, and supporting students while
using SAS software.

Step 1. Confirm system requirements

Check these guidelines to ensure your students can access the software.

Confirm requirements for full support.

Instructor and student systems must meet these requirements for SAS OnDemand for
Academics: Forecast Server to be fully supported.

Supported

Not Supported

Operating
systems

Java Runtime
Environment

Hard disk space
Internet browser
Internet
connection

Network
bandwidth

Any system that supports the Sun
Microsystems (Oracle) Java Runtime
Environment (JRE). Typically, this
includes Unix, Linux, and various
Microsoft Windows operating systems,
such as Microsoft Windows XP and
Microsoft Windows Vista.

Java Runtime Environment (JRE)
Version 1.6.0_18.

Note: You will be prompted to check
for this JRE and install it when you
install SAS Forecast Server.

At least 50 MB of free hard disk space
Any browser that supports JRE 1.6.0_18
High speed, including broadband
(cable), DSL (phone), and wireless
connections.

Note: Individual usage experience
depends on speed and reliability of
connection.

For best performance, at least 1000
Kbit/sec is recommended.

Macintosh operating systems
Note: Virtualized
environments might not
work. It is recommended that
supported operating systems
run on a physical CPU.

JRE 1.6.0_20 is not
compatible.

Note: Other JREs from the
1.6 series might series might
work.
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Verify network performance

If you plan to teach in a lab or a seminar setting in which many students will access and
use SAS OnDemand for Academics software applications at the same time, then you
should verify the performance of the network that you plan to use (Internet bandwidth,
wireless router capacity, and so on).

If the network performance is not sufficient, then your students could experience slow or
dropped connections to the hosted SAS Servers that are used to perform SAS processing.

You can contact the appropriate network or IT department personnel to request
additional information. Share the following information with them to ensure they gather
accurate data:

O Type of network connection you plan to use (Wireless, LAN, or other) In
particular, wireless networks can be problematic as there are sometimes stricter
limits to the capacity of concurrent users that they can support.

O Number of students that will use SAS OnDemand for Academics concurrently

O Location of the lab or seminar

O Location of the hosted SAS Servers (the answer is: Cary, North Carolina at SAS
Institute)

There are also a number of tools available through the Internet that you or the
appropriate network personnel can use to check network performance. SAS also offers a
tool that might help. To access this tool, perform the following steps:

1 Go to the following Web site: http:/netcheck.sas.com/ookla.

2 Select Test 3.

Note: If you are not teaching in a lab or seminar setting, then each student must
connect to the hosted SAS Servers to perform processing using their own high-speed

Internet connection. If individual students have network connection issues, they can try
to use a computer on a different network or contact their Internet Service Provider.

Verify and install a Java Runtime Environment (JRE)

After you have created a course (if you are an instructor) or registered for a course (if
you are a student) that uses SAS OnDemand for Academics: Enterprise Miner, you must
verify that you have an appropriate Java Runtime Environment (JRE) installed or
install an appropriate JRE. This process needs to be completed only once.

Note: Consider printing these instructions before you begin as some of the steps might
require you to move to other Web sites.

Step One: Verify whether a JRE (and Java Web Start) is installed
To verify whether you have a JRE installed, try the following:

1 Open a Command Prompt window. Select Start » Run.
2 Type CMD in the Run window.

3 On the Command Prompt window, type start javaws.
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4 1If the above command opens a Java Web Start window similar to the following,
then you have a JRE (and Java Web Start) installed.

Java(TM}) Web Start 1.6.0_06 1[

\E) Usage: javaws [run-options] <jnlp-file>
javaws [control-options]

where run-options include:
-verbose display additional output

-offline run the application in offline mode

-syskem run the application from the system cache only
-¥nosplash run without showing a splash screen
-J<option = supply option to the vm

-ait start java process and wait For its exit

control-options include:

-viewer show the cache viewer in the java control panel
-uninstall remaove all applications from the cache
-uninstall <jnlp-file= remove the application from the cache

-impart [import-options] <jnlp-file=  import the application ko the cache

import-options include:

-silent impoort silently {with no user inkerface)
-syskem import application into the system cache
-codebase <url= retrieve resources from the given codebase
-shorkeut install shortcuts as if user allowed prompt

-association install associations as if user allowed prompt

If you have a JRE installed, then continue to Step Two. If the above command did not
work, then you likely do not have a JRE installed. Continue to Step Three.

Step Two: Ensure that you are using only the recommended Java Runtime
Environment

We recommend that you use Java Runtime Environment (JRE) 1.6.0_18 to run SAS
OnDemand for Academics: Forecast Server. Only JREs with U.S. Export Control
Classification Numbers of 5D992 are approved for use with SAS products.

Note: Other JREs from the 1.6 series might also work (excluding JRE 1.6.0_20, which
is incompatible).
1 From a Command Prompt window, start Java Web Start. Type start javaws -
viewer and then press ENTER.

2 Ifthe Java Cache Viewer window appears, close it so that you can see the Java
Control Panel window. The Java Control Panel window often opens behind the
Java Cache Viewer window.

From the Java Control Panel window, select the Java tab.

From the Java Application Runtime Settings area (the bottom half of the
window), click View (the second "View" button on the window).

5 In the Enabled column, check only one JRE (uncheck any other JREs that are
checked). We recommend that you check JRE 1.6.0_18.

If JRE 1.6.0_18 is unavailable, then you can test SAS OnDemand for Academics:
Forecast Server with your current JRE. To do so, you can start from your SAS
OnDemand for Academics Home Page.

If your current JRE does not work or if you want to install the recommended JRE,
continue to Step Three. Otherwise, configuration is complete.
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Step Three: Install the recommended Java Runtime Environment and Java
Web Start

Installing the recommended JRE will also install Java Web Start on your system.

Note: If you completed Step Two above, repeat this step to ensure that only JRE
1.6.0_18 is selected.

1 Access the Java SE Downloads Web Site.

http://www.oracle.com/technetwork/java/javasebusiness/downloads/java-archive-
downloads-javase6-419409.html#jre-6ul8-oth-JPR

Alternatively, you can access the Java SE 6 Downloads archive page at

http://www.oracle.com/technetwork/java/archive-139210.html, then click Java SE
6. On the Java SE 6 Downloads page, select Java SE Development Kit SE 6ul8
from the list.

Click the radio button to Accept License Agreement.
Select jre-6ul8-windows-i586.exe under Download column.

You will be prompted to sign in to your Oracle Web account. If you do not have an
account, you will be prompted to create one.

5 After you are signed in, launch the download and select Run to begin the
installation process.

6 (Optional) If you completed Step Two above, repeat this step to ensure that only
JRE 1.6.0_18 is selected.

Step 2. Set up your SAS® OnDemand for Academics account

As an instructor, there are several important steps you must follow to set up a SAS
OnDemand for Academics account, such as creating a SAS profile and registering
yourself and your course. The online process uses a series of windows to guide you.

About the SAS OnDemand for Academics Control Center

Your starting point for accessing SAS OnDemand for Academics is the SAS OnDemand
for Academics Control Center Web site: http:/support.sas.com/ctx3/sodareg/index.html

As an instructor you will use the Control Center to register your account, create courses,
view course information, edit course information, and delete courses. Your students will
use it to register, acquire a license, and view course information.

Your SAS OnDemand for Academics Home Page is created during the registration
process and is part of the SAS OnDemand for Academics Control Center. You will be
taken to your Instructor Home Page once you have set up an account. You access your
home page to register, view, or edit information associated with courses.

About your SAS Profile account

A SAS Profile is an account that you can create to access specific information and
resources from the SAS Web site. If you are a current SAS user, you might already have
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a SAS Profile. If you are a new SAS user, a SAS Profile is created for you when you
register for SAS OnDemand for Academics.

An important part of your SAS Profile account is a SAS Profile password that you are
prompted to enter each time you access the SAS OnDemand for Academics Control
Center.

Note: Your SAS Profile password must be changed every 6 months for security
purposes. You will receive an e-mail when your password is approaching expiration. To
reset your SAS profile, visit My SAS Profile page at this location:
https://www.sas.com/profile/user/login.htm.

Important information hefore you begin

As you begin setting up your account, it's helpful to keep the following in mind:

O You will need access to your e-mail account. When you begin registration, you will
be prompted to enter an e-mail address. Enter the e-mail address of an account
that you can access easily while completing your registration.

O You will receive an e-mail during the initial registration process that you must
open and act upon to continue. The e-mail prompts you to click a link to verify
your e-mail address. Its primary purpose is to confirm that you are using a valid e-
mail address and that someone else is not attempting to register you without your
knowledge.

O Ifyou do not receive the e-mail, please check your junk e-mail folder.

About SAS Forecast Server environments

SAS Forecast Server requires that an environment be established and that projects exist
within an environment. With SAS OnDemand for Academics: Forecast Server, each
course is set up to be its own environment by default. Any user within that course is
automatically a part of that environment and can create and work with projects within
that environment.

SAS Forecast Server is also a collaborative tool. This means that all users within a
specific course can view and work with the projects in that course's environment.

Register as an instructor

Only instructor accounts have the ability to create, edit, or delete courses. If a teaching
assistant is going to act as an instructor, then they must register as an instructor. A
unique e-mail address must be used for the instructor account if the teaching assistant
already has a student account. There is no cost or obligation associated with registering
as an instructor, and following these steps prepares you to use this offering and provide
better guidance for your students:

1 Go to the SAS OnDemand for Academics Control Center
(http://support.sas.com/ctx3/sodareg/)

Enter New User.
Follow the online prompts to create your SAS profile.

Continue with your registration until you arrive at your Instructor Home Page.
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Once on your Home Page, you can then register a course.
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Register a course

The SAS OnDemand for Academics team creates a custom environment for each course
using SAS Forecast Server. Please allow up to one business day for the environment to
be created.

Note: To avoid confusion and unnecessary support calls, it is important to complete
this step before you invite students to register for SAS OnDemand for Academics When
students register, they must select a university, an instructor, and a course. If you invite
students to register before you have registered a course, they won't be able to select your
course.

1 Go to the SAS OnDemand for Academics Control Center
http://support.sas.com/ctx3/sodareg/index.html

Log on using your e-mail address and your SAS Profile password.
You will arrive at your Instructor Home Page.

Click Register a Course and then follow the instructions.
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Once your course is registered, SAS will set up the course environment on the SAS
Server and send instructors an email with the appropriate identifier for use
during the course.

Step 3. Access and use the software

By accessing using the software ahead of time, you will be able to anticipate possible
student issues, develop content that might be specific to using SAS OnDemand for
Academics, and have an understanding of how long it should take students to access the
software themselves.

Ideally, you should perform this step before you develop your course outline as SAS
OnDemand for Academics software applications function slightly differently than their
traditional SAS software counterparts. There are a number of resources available to
help you.

Access your SAS OnDemand for Academics account

Your SAS OnDemand for Academics account enables you to view and/or edit information
associated with courses. You will have access to this information after you have initially
registered for SAS OnDemand for Academics.

To access an existing SAS OnDemand for Academics account:

1  Access the SAS OnDemand for Academics Control Center at the following Web
site: http://support.sas.com/ctx3/sodareg/index.html

2 Enter your e-mail address and your SAS Profile password and then click Enter.

Locate the name of your SAS Forecast Server environment

Each course registered using SAS Forecast Server will have a unique course
environment. Instructors can locate the name of their course environment by following
these steps:

1 Log on to your SAS OnDemand for Academics Home page.
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From the Course table, locate the appropriate course.
Click Get Software.

Review the section called Starting SAS OnDemand for Academics: Forecast
Server. The environment for your course will be listed in step 3.

Access SAS Forecast Server

After you have reconfigured your system to support SAS OnDemand for Academics:
Forecast Server and registered your course, you can start the application by following
these steps:

1 Log on to your SAS OnDemand for Academics Home page.

2 From the Manage Courses area, select Get Software next to the appropriate
course. Selecting this link will open a window that includes information about how
to configure your system as well as how to start the application.

3 Click the link that is used to start SAS OnDemand for Academics: Forecast Server
(http://emcloud.oda.sas.com:16401/Forecasting/main.jnlp).

If you are presented with a security warning, select Run.

In the User Name field, enter your SAS Server user ID. This user ID is also
displayed on your SAS OnDemand for Academics home page:

~ Getting Started

A Your SAS Server userid it sas.instructor

Use this userid when you log on w e SAS Server.

= Reqgister a course:
Registering a course will make it available to your students.

To edit course information or review helpful details about courses, click on the course title. To obtain the software for a course
select the link in the Download column.

Note: Your SAS Server user ID is case sensitive and should be entered in all
lowercase. If you enter your SAS Server user ID using uppercase or mixed case
letters, you might be able to log on, but certain tasks might not perform properly.

6 In the Password field, enter your SAS Profile password. There are two times
when you might have supplied a SAS Profile password: either when you originally
created a SAS Profile or when you registered for SAS OnDemand for Academics.

7 Click Log On.
To start SAS OnDemand for Academics: Forecast Server in the future, you can perform

the previous steps or simply save the following URL as a bookmark and use it:
http://emcloud.oda.sas.com:16401/Forecasting/main.jnlp

Access the SAS Server

You are prompted to connect to the SAS Server each time you start SAS OnDemand for
Academics: Forecast Server. The server (which is hosted at SAS Institute Inc.) remotely
processes any submitted SAS files or projects and returns results to your computer.

Make sure that you have a working Internet connection if you are unable to use a SAS
OnDemand for Academics software application to perform processing. If your internet
connection is working normally, it is likely that the SAS Server is temporarily
unavailable. Please try to use the server again later. You can also log on to the SAS
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OnDemand for Academics Control Center. The SAS OnDemand for Academics Control
Center typically provides a message if the SAS Server is unavailable or expected to be
unavailable in the near future.

SAS Server maintenance and availahility

SAS makes its best efforts to make the server available as much as possible and to keep
unexpected downtime to a minimum. There could be limited times when the server is
unavailable because SAS is performing maintenance, testing, or performance
enhancement tasks.

O Ifserver maintenance is needed, SAS will try to perform this work during
nontraditional usage hours to lessen any impact to users.

O SAS uses the third Saturday of each month to perform scheduled maintenance on
its systems (if needed). Therefore, the server might be unavailable for a portion of
time on the third Saturday of each month.

To determine if SAS servers are available, visit the SAS Server status Web page:
(https://www.ondemand.sas.com/status/oda/).

Requesting SAS Server availahility notification

If you would like to be notified when the SAS Server is unavailable due to extended
maintenance or due to unforeseen circumstances, please subscribe to the
SASONDEMANDSERVER-L mailing list:

1 Send e-mail to LISTSERVRLISTSERV.SAS.COM.
2 In the body of the e-mail, type subscribe SASONDEMANDSERVER-L

3 Send the e-mail (no subject line is needed). Follow any instructions you receive via
e-mail.

To unsubscribe from SASONDEMANDSERVER-L, perform the following steps:
1 Send e-mail to LISTSERVRLISTSERV.SAS.COM.
2 In the body of the e-mail, type unsubscribe SASONDEMANDSERVER-L

3 Send the e-mail (no subject line is needed)

Step 4. Prepare course data

Due to its architecture, both local data and data uploaded by instructors are unavailable
for use with SAS OnDemand for Academics: Forecast Server. Please use the default SAS
data sets provided on the SAS server when using this offering.

To view the available SAS libraries, use the appropriate method to browse data within
SAS OnDemand for Academics: Forecast Server.

Step 5. Review and test Course Materials

This offering is designed for teaching purposes only. Although SAS Forecast Server is
capable of generating forecasts and reconciling estimates across very large SAS data
sets with deep hierarchical structures, for the purpose of teaching we have limited the
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number of levels of a hierarchy to three (for example: state, store, product). Three levels
are sufficient to demonstrate top-down, middle-out, and bottom-up reconciliation of
forecasts for students.

Instructors are further cautioned that SAS data sets with a significant number of
categories within a hierarchy might require processing time longer than what is
appropriate for the typical live classroom setting.

Importance of reviewing course materials

In some cases, the steps needed to complete certain tasks might be different when using
SAS OnDemand for Academics software applications (versus traditional SAS software
applications). By reviewing and testing your course materials prior to class, you can
prepare yourself and your students for any minor differences.

Note: While it might take 30 minutes or less to review available course information
and test the information against SAS OnDemand for Academics, you might have to
register for and/or request course materials from SAS (if applicable). This process could
take a few days. Please plan accordingly.

Teaching materials provided by SAS

SAS Education provides certain teaching materials free of charge to instructors at
degree-granting academic institutions. These materials include an electronic copy of
course notes, slides, and in some cases, code and data. The materials are not available
for use by students. Visit Teaching materials from SAS at the Training & Bookstore for
SAS Global Academic Program at http:/support.sas.com/learn. In some cases, we have
already uploaded the SAS data sets used by popular teaching materials.

Note: Prior to downloading the course materials, an instructor must register for SAS
OnDemand for Academics. Additionally, instructors will be required to accept a license
agreement that specifies the terms and conditions of usage.

The materials were developed for users who are running SAS locally. Certain SAS code
examples might not work or might need to be modified.

Books, training, and other reference materials

SAS Publications are available online at http:/support.sas.com/publishing. You can find
books, review portions of each book, and place orders.

SAS Publishing offers products to qualified college faculty who are interested in
teaching SAS. For more information, see the Academic Evaluation Copy Program.

Other publications are available for download from the SAS OnDemand for Academics
Web site on http:/support.sas.com/ondemand.

Step 6. Share course information with students

After you create your course, prepare your data, and become familiar with the software,
you should:

O invite your students to register for your SAS OnDemand for Academics course
O provide important information on how to access the course software and data
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We recommend that you ask your students to complete these steps prior to the
beginning of your course (if possible) or during the first week of your course. Some
instructors choose to use the first class of a course to review how to perform these steps.

Ask students to register for SAS OnDemand for Academics

When you create a course within SAS OnDemand for Academics, you are presented with
text that you can copy and paste in to an e-mail to send to your students. This text
provides the information that your students will need to register for SAS OnDemand for
Academics and download the appropriate software application.

If you don't copy and paste the text when you initially create a course, you can access
the information again at any time:

1 Log on to your SAS OnDemand for Academics Home Page.

2 Under the Manage Courses area, click the Info link next to the appropriate
course.

3 Select View a sample message.

A generic version of the e-mail text is provided below as an example. You can copy,
paste, and customize this text if needed. For example, if you have a coupon code that
students need to use, you can include that code in your e-mail.

Dear student:

I plan to use SAS OnDemand for Academics: Software Application Name software to teach course
name.

As a student in my class, you will need to register for SAS OnDemand for Academics and then
access SAS OnDemand for Academics: Software Application Name.

Here's how to get started:

1. Access the SAS OnDemand for Academics Control Center at the following URL:
http://support.sas.com/ctx3/sodareg/index.html

2. Review the information and follow the steps at this site.

3. If you have additional questions, review the information about using SAS OnDemand for Academics at
http://support.sas.com/ondemand or contact me.

Thank you.
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Provide students with information ahout the system

While it is up to you to determine how you want to invite your students to participate,
we recommend that you send e-mail to the students on your course roster. In the e-mail,
it might be useful to:

O highlight system requirements, especially if you think the requirements could be
an issue for some students. Please note that the SAS OnDemand for Academics
products are not supported on Macintosh computers.

O include step-by-step installation instructions.

Suggested information to share with students

How to register for SAS OnDemand for Academics. A printable, step-by-step guide
“SAS OnDemand for Academics: Forecast Server, Student Registration Instructions” is
available from http://www.sas.com/govedu/edu/programs/forecastserver_student.pdf.

As an instructor, you might want to share copies of the guide or links to the appropriate
guide with your students.

How to start SAS Forecast Server. After registering for SAS OnDemand for
Academics, students just click the link from their SAS OnDemand for Academics Home
Page to start SAS Forecast Server
(http://emcloud.oda.sas.com:16401/Forecasting/main.jnlp).

Step 7. Review the hasics for working with data and results

During the first week of class, we recommend that you review with your students the
basics of working with SAS data sets and results in SAS OnDemand for Academics:
Forecast Server.

About project storage

By default, all SAS OnDemand for Academics: Forecast Server projects are stored on the
SAS server. Due to the architecture of this offering, there is no way to save your projects
locally.

The large size of projects and their forecasts might also prove to be problematic to save
locally. In a teaching setting, sharing the results of your forecasting projects should be
sufficient.

Working with forecasting project results

Students can share their results (graphs) with instructors should that be necessary to
support course assignments. Instructors can also save or share the results of their
forecasting project work. To do so:

Start SAS OnDemand for Academics: Forecast Server.
1 Open the appropriate project.
2 Rerun the project (if necessary) to produce the appropriate graph.

3 Select Tools --> Reports and Stored Processes.
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4 From the Output Options, select a report format and then click Run.

5 Save the report or export the report data to another program. For example, if you
choose HTML as the report format, you can generate the report, right click on the
report, and then export the data to Microsoft Excel. If you choose CSV as the
report format, then the report will generate within Microsoft Excel (provided that
you have the application) by default.

6 Share the report as needed.

Step 8. Help for Common Problems

Please check the commonly asked questions about SAS OnDemand for Academics:
Enterprise Miner in this section and follow the procedures below for additional help.

Where can instructors find help?

Please follow the steps below to resolve any technical issues.

Step 1: Review Commonly Asked Questions, SAS Notes, and SAS
Documentation

Use the key word 'ondemand academics' to search for issues specific to SAS OnDemand
for Academics from these sources:

O Commonly Asked Questions about SAS® OnDemand for Academics in this manual

O SAS Notes, a database of common technical issues found on
http://support.sas.com/notes

O SAS Product Documentation on http:/support.sas.com/documentation

Step 2: Contact Your SAS Site Representative (if applicable)

If you are an instructor at a university that already uses SAS Software, then you might
have a SAS Site Representative who can provide SAS support.

If you are unsure about whether you have a SAS Site Representative, contact the person
or department that supports your university's software purchases and installation.

Step 3: Contact SAS Technical Support (Instructors)

SAS Technical Support is designed to assist you with technical issues such as
installation or setup questions. They are not available for providing training or
answering basic usage questions.

If the above steps have not resolved your issue, please contact SAS Technical Support:

1 Open the SAS Technical Support Problem Form found on
http:/support.sas.com/techsup.

2 Fill out and submit the form. When filling out the form, use the following values:
O For Company Name, enter SAS OnDemand for Academics.
Q For Site Number, enter 00700315

Optionally, e-mail your support request to support@sas.com. Be sure to specify that
you are using SAS OnDemand for Academics.
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Where can students find help

Students should be asked to follow the steps below to resolve any support issues they
encounter:

Step One: Review Commonly Asked Questions, SAS Notes, and SAS
Documentation

Use the key word 'ondemand academics' to search for issues specific to SAS OnDemand
for Academics from these sources:

O Commonly Asked Questions about SAS OnDemand for Academics in this manual

O SAS Notes, a database of common technical issues found on
http://support.sas.com/notes

O SAS Product Documentation on http:/support.sas.com/documentation

Step Two: Contact Your Instructor

If you are a student and you have questions about using SAS OnDemand for Academics,
contact your instructor. Instructors can point students toward educational resources and
help ensure that offerings are used correctly.

If further assistance is needed, then your instructor can contact SAS Technical Support.

Commonly Asked Questions for SAS OnDemand for Academics:
Forecast Server

O How do I configure my PC to use SAS OnDemand for Academics: Forecast Server?
In order to use SAS OnDemand for Academics: Forecast Server, you must first
ensure that your PC is properly configured and that you have the appropriate
Java Runtime Environment installed. For step-by-step instructions, see “Step 1:
Confirm system requirements” for SAS OnDemand for Academics: Forecast Server

O How do I start SAS OnDemand for Academics: Forecast Server?

After you have configured your system to support SAS OnDemand for Academics:
Forecast Server, you can start the application:

1 Log on to your SAS OnDemand for Academics Home page.

2 From the Manage Courses area, select Get Software next to the appropriate
course. Selecting this link will open a window that includes information about
how to configure your system as well as how to start the application.

3 Click the link that is used to start SAS OnDemand for Academics: Forecast
Server (http://emcloud.oda.sas.com:16401/Forecasting/main.jnlp) .

4 Ifyou are presented with a security warning when you attempt to start SAS
OnDemand for Academics: Forecast Server, select Run.

5 In the User Name field, enter your SAS Server user ID. This user ID is also
displayed on your SAS OnDemand for Academics home page:

Note: Your SAS Server user ID is case sensitive and should be entered in all
lowercase. If you enter your SAS Server user ID using uppercase or mixed case
letters, you might be able to log on, but certain tasks might not perform

properly.
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6

10
11

Notes:

In the Password field, enter your SAS Profile password. There are two times
when you might have supplied a SAS Profile password: either when you
originally created a SAS Profile or when you registered for SAS OnDemand for
Academics.

Click Log On.

To start SAS OnDemand for Academics: Forecast Server in the future, you can
perform the previous steps or simply use the following URL:
http://emcloud.oda.sas.com:16401/Forecasting/main.jnlp.

O Iam an instructor. Can I upload data files to use with SAS Forecast
Server?

Unlike some of the other software applications available through SAS
OnDemand for Academics, the data that an instructor uploads for their
course(s) is unavailable for use with SAS Forecast Server. Instead, both
instructors and students must make use of the default SAS data sets
provided with SAS OnDemand for Academics.

Q When I start SAS OnDemand for Academics: Forecast Server, the software
application appears to be named SAS Forecast Studio. Am I using the
correct software?

Yes. SAS Forecast Server is the name of the software offering. However,
SAS Forecast Studio is the name of the graphical user interface that is
used to access SAS Forecast Server functionality.

O What is the name of my SAS Forecast Server Environment?

Each course registered using SAS Forecast Server will have a unique
course environment. Instructors can locate the name of their course
environment by following these steps:

Log on to your SAS OnDemand for Academics home page.
From the Course table, locate the appropriate course.
Click Get Software.

Review the section called Starting SAS OnDemand for Academics: Forecast
Server. The environment for your course will be listed in step 3

Note: Students will need to contact their instructor if they do not know
which environment to select.
O How do I select a SAS Forecast Server Environment?

Instructors and students can select their course environments by doing the
following:

Log on to SAS Forecast Server.

From the Project window, select your course environment from the
Environment drop down menu.

Q The SAS OnDemand for Academics team creates a custom environment for each
course using SAS Forecast Server . Please allow up to one business day for the
environment to be created.

O Students must contact their instructors if they do not know which environment to
select.
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Commonly Asked Questions for SAS OnDemand for Academics

This appendix answers questions that apply to all SAS OnDemand for Academics
software products. For help with specific products, see “Commonly Asked Questions” for
the SAS OnDemand for Academics software that you are using.

General/Cost/License

0O How long is my license period?
The license period lasts six months.

0 What is the cost?
It is free for professors and free to students in registered classes.

O What is the difference between the EAS license and the SAS OnDemand for
Academics license for students and professors?

Your SAS account representative can help you decide what is the best option for
you to use to teach with SAS software. Contact your SAS academic account
representative by calling 800-727-0025 and select option two.

O Is SAS OnDemand for Academics accessible to users with disabilities?

SAS is aware that academic and other institutions are required to satisfy the
accessibility standards contained in Sections 504 and 508 of the Rehabilitation Act
(29 U.S.C. 794d) with respect to their use of electronic and information technology.
SAS has tested SAS OnDemand for Academics and SAS OnDemand for
Academics: Enterprise Guide against relevant standards with the assistance of
students who use assistive technologies.
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Availahility and Installation

O Who can use SAS OnDemand for Academics?

SAS OnDemand for Academics is available only to college instructors and their
students. It is not intended for use by researchers.

SAS OnDemand for Academics is available for international usage in English only.
We recommend that instructors test the use of this offering before including it in a
course to ensure performance is acceptable.

0 What can I expect during the registration process?

Whether you are an instructor or a student, there are several parts to the
registration process, so it's helpful to keep the following in mind:

O The registration process uses a series of windows to guide you.

O You will need access to your e-mail account during the registration process.
When you begin registration, you will be prompted to enter an e-mail address.
Enter the e-mail address of an account that you can access easily while
completing your registration.

O You will receive an e-mail during the initial registration process that you must
open and act upon to continue. The e-mail prompts you to click a link to verify
your e-mail address. Its primary purpose is to confirm that you are using a
valid e-mail address and that someone else is not attempting to register you
without your knowledge.

Q Which Internet browsers can I use with SAS OnDemand for Academics?

An Internet browser is required to use the SAS OnDemand for Academics Control
Center (registration, course selection, and so on) as well as to download SAS
OnDemand for Academics software. We recommend Microsoft Internet Explorer 7
(or earlier) for Microsoft Windows systems. Safari and Mozilla Firefox might be
appropriate for Macintosh systems. While other browsers might work with the
offering, they have not been fully tested.

O What is a SAS Profile?

A SAS Profile is an account that you can create to access specific information and
resources from the SAS Web site. If you are a current SAS user, you might already
have a SAS Profile. If you are a new SAS user, a SAS Profile will be created for
you when you register for SAS OnDemand for Academics.

0 Can SAS OnDemand for Academics software be installed on university lab
machines?

An employee of a university can download SAS OnDemand for Academics software
with the intent of installing it on university lab machines (per the legal click
license that must be accepted when registering for SAS OnDemand for
Academics).

After the software is installed on the lab machines, only registered users of SAS
OnDemand for Academics have the right to use it; these users must log on to the
SAS Server using the credentials that were provided to them when they registered
for the service.
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General Usage

O How do I log on to my SAS OnDemand for Academics Home Page?

Your SAS OnDemand for Academics Home Page is part of the SAS OnDemand for
Academics Control Center. The Control Center is used by students to register,
purchase courses, and view course information. The Control Center is used by
instructors to register, create courses, view course information, edit course
information, and delete courses.

To log on to your SAS OnDemand for Academics Home Page, see “Access your SAS
OnDemand for Academics account” for the SAS OnDemand for Academics
software that you are using.

O I've used the correct log on values and I still can't connect to the SAS Server to
perform processing. What's wrong?

There are a few common reasons why you might not be able to connect:

Q@ You might have a brand new account. Your account will be activated within 15
minutes of registration, and then you'll gain access to the SAS Server.

Q The SAS Server might be temporarily down for maintenance.
O Your account status might be Pending.

O Your SAS Profile password might have expired. This password must be reset
after 180 days (approximately six months). For more information, see
Resetting your SAS Profile Password.

O Your SAS Profile password might be too weak. See “What is a SAS Profile?” for
the SAS OnDemand for Academics software that you are using.

O Your account might have expired. Student accounts are valid for the duration
of the registered course (plus a grace period to ensure that assignments can be
completed).

O The SAS Server might be down at certain times for maintenance, testing, or
enhancements. If you are unable to connect, make sure that you have a
working Internet connection. If you do and you still cannot connect, please try
again at a later time. For more details, see “SAS Server maintenance and
availability” for the SAS OnDemand for Academics software that you are
using.

O My connection to the SAS Server failed after I left my machine. What happened?

An open connection to the SAS Server will likely disconnect (time out) after one
hour (or less) if the connection is idle (that is, you have not performed any
processing). Many firewalls disconnect open sessions after an hour of idle time (or
less). SAS recommends that you complete your work, save it, and then exit SAS
OnDemand for Academics before you leave the computer.

O How do I define a course?

Only instructors can define courses. To define a course, log on to the SAS
OnDemand for Academics Control Center. Next, select Register a Course from
your home page to begin. For information about editing or deleting existing
courses, see How do I edit or delete a course?

O How do I edit a course?

Instructors have the ability to edit a course until a student registers for the
course. To edit a course, log on to the SAS OnDemand for Academics Control
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Center to access your home page. From the Manage Courses area, find the course
that you want to update then select edit. Update the course information as needed
and then select Submit to save the changes.

Can I collaborate with other users?
Currently, there are a few ways that you can collaborate:

O You can share files through network storage space that both parties can access
(such as AF'S or NFS mounted drives).

Q If an instructor chooses to store data on the SAS Server for a course, then the
students in that course can all share the same data by using the LIBNAME or
FILENAME statement that the instructor provides.

O You could consider using third party tools, such as www.blackboard.com.

I'm a professor. Can I add students to my class from other countries?

When you create a course, that course (as well as any data that you upload for
your students) is connected to the set of hosted academic servers that are in your
geographical region (for example, Europe or the United States).

When a user registers for SAS OnDemand for Academics, they are automatically
associated with the set of hosted academic servers that are in their geographic
region. If an instructor and a student are not associated with the same hosted
academic servers, then the student can still use the offering, but they will not have
access to any data that the professor has uploaded for the class.

For example, if a professor in France has a student in the United States, then that
student won't have access to any data that the professor has uploaded. The
student could still use all of the other features of the offering.

I'm an instructor and I am receiving a "permission denied" error when trying to
use FTP to store data on the SAS Server. What's wrong?

Your FTP client could be in passive mode. For more information, see
“Encountering permission denied errors while using FTP” for the SAS OnDemand
for Academics software you are using.

Can I point to local SAS data sets or files using a LIBNAME or a FILENAME
statement?

No. The SAS Server is unable to access or recognize the local drives of your PC. If
you write a LIBNAME statement or a FILENAME statement that references a
local directory path, you will receive processing errors. To determine which data
storage option is available for your course, see “Options for providing course data
to students” for the SAS OnDemand for Academics software that you are using.

Can I store files on the SAS Server?

Instructors have the ability to store data files on the SAS Server. Other types of
files (such as program files, course notes, or directories) are not allowed. Once a
data file has been stored on the SAS Server, students and instructors can access it
using an appropriate LIBNAME or FILENAME statement. Instructors are
provided with a unique LIBNAME and FILENAME statement for each course
that they teach in case they decide to use the SAS Server to store data files.

I have uploaded a SAS data set, but I can't see or access it. What is wrong?

Please be sure that the SAS data set that you uploaded is named using all
lowercase letters. Our hosted servers use Unix; they do not recognize mixed or
uppercase letters. If you have uploaded a SAS data set that uses mixed or
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uppercase letters, simply rename the SAS data set to use all lowercase letters
(with no spaces in the name) and then upload the SAS data set again.
O Iam an instructor. Can I upload data from third party sources to the SAS Server?

Some universities purchase third party data sources or use open source third
party data sources. Often times, these data sources are protected by specific
license agreements or terms of use. It is your responsibility to do the following:

Q ensure that you have the right to upload third party data sources to the
SAS Server

O verify that usage of the third party data sources does not violate any third
party rights or any applicable laws or regulations

O review the license agreement or terms of use for the third party data sources
in question prior to uploading this type of data to the SAS Server

O Is there a limit to the number of times I can submit SAS jobs to the SAS Server?
No. There is no limit.

O Can I use the SAS Server with other SAS software that I have licensed?
No. The SAS Server has been configured to support only software client
applications associated with SAS OnDemand for Academics.

O Ireceived an error message when trying to create a folder on the SAS Server.
What's wrong?
You may receive an error message such as this:

“A call to the metadata repository failed. See details for more information.”

In this case, it's likely that you were trying to create a folder on the SAS Server.
This behavior is not currently supported because it is not possible to save your
work on the SAS Server. Instead, please save any work to a local folder. When
prompted to save your work, select Local Computer instead of SAS Servers and
then select the appropriate local directory.

General Support

0 What should I do if I forget my password?

You need to use a password to log on to SAS OnDemand for Academics or to
connect to the SAS Server (SAS Cloud) when prompted by SAS OnDemand for
Academics: Enterprise Guide. In all cases, your password is the same as your
SAS Profile password. If you have forgotten your SAS Profile password, then
follow these steps:

1 Use the My Profile page to update your SAS Profile password:
(https://www.sas.com/profile/user/login.htm) .

Note: Your password must meet the following criteria:

a. It cannot be the name that you used to register or exceed two consecutive
characters from that name. For example, if you registered as ‘Jonathan Smith’,
you could not use either ‘Jonathan’ or ‘Smith’ and you could not include three
consecutive characters such as ‘jon’ or ‘ith’.

b. It must be at least eight characters in length.
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It must contain characters from three of the following four categories:

O English uppercase characters (A through Z)

O English lowercase characters (a through z)

O Base 10 digits (0 through 9)

0 Non-alphabetic characters (for example, !, $, #, %)

2 Access SAS OnDemand for Academics.

3 Enter your e-mail address and use your updated SAS Profile password when you
are prompted to enter a password.

4 When appropriate, use your updated SAS Profile password (along with your SAS
Server User ID) to log on to a SAS OnDemand for Academics software application.

a
a

a
a

If I have trouble with my software, how do I get support?

Please refer to the information in this manual under “Step 8. Help for
Common Problems” for the software being used in your course. If you are an
instructor, you can send your request to this email address:
support@sas.com. Be sure to specify that you are using SAS OnDemand for
Academics.

How will students find out about SAS OnDemand for Academics?

Instructors are responsible for communicating their intent to use SAS
OnDemand for Academics with their students. When an instructor registers a
course with SAS OnDemand for Academics, a confirmation window appears
that includes optional “student message” text. This text can be copied and
pasted in to an e-mail message that can then be sent to students. Additionally,
the optional “student message” text can also be accessed again if the instructor
edits one of their registered courses. Instructors can also choose to compose
their own student message, if desired.

When will my SAS OnDemand for Academics license expire?

SAS OnDemand for Academics student licenses are good for the duration of
the registered course (plus a short grace period to ensure that students can
complete assignments). While instructor licenses have no expiration date, an
instructor might have to re-register in the future to receive updates.
Information will be provided through e-mail as needed.

How can I check my account status?

To determine the status of your SAS OnDemand for Academics account, do the
following:

5 Access SAS OnDemand for Academics Control Center
(http://support.sas.com/ctx3/sodareg/index.html)

Enter your e-mail address and your SAS Profile password and then click Enter.

Review the Status Indicator at the top of your SAS OnDemand for Academics
home page. Your status will be one of the following values:

a
a

Active - You are a current user and your account is working properly.

Pending - You have a user ID, but it is not yet active. If you are a student,
your status will change to Active after you registered for a course license.

If you have completed registration steps (including creating a course if you are
an instructor or registering for a course license if you are a student) and you
still see a status of Pending, then log out of the SAS OnDemand for
Academics Control Center and then log back in. Repeat this step until your
status changes to Active.
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O Password Expired - Your SAS Profile password has expired.

O Disabled - Your account has expired or the SAS Administrator has turned off
your license in accordance with the terms of the legal agreement. If your
account has expired, you can enable your account again by registering for
another SAS OnDemand for Academics course (if your instructor chooses to
teach a course with SAS OnDemand for Academics).
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Learning Resources for SAS OnDemand for Academics

This appendix lists resources that are available for instructors and students on
http://support.sas.com. Some resources are offered at no cost; others are available for
purchase only.

Note: If any of the supporting materials identified in this appendix are not inherently
accessible and you require an accessible format, please send e-mail to
ondemandacademics@sas.com. SAS will work with you to provide an accessible
format.

Training and Usage Videos

SAS has designed following videos have been designed to help you learn more about SAS
OnDemand for Academics or to help you learn how to perform tasks quickly. The titles
listed below are available at no cost at http:/support.sas.com/ondemand/videos.html.

Professors

O Registering for SAS OnDemand for Academics: For Professors

O Creating a course for SAS OnDemand for Academics: For Professors

O Uploading SAS Data Sets to the SAS Servers using FTP: For Professors
O Using a LIBNAME Statement: For Professors
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Students

Q
Q
Q

Registering for SAS OnDemand for Academics: For Students
Using a LIBNAME Statement: For Students
Using a FILENAME Statement: For Students

e-Learning Courses

SAS provides many e-Learning courses (e-Courses) to help you learn how to use our
software. The following e-Courses have been specifically designed to work with SAS
OnDemand for Academics:

O0OD0O00DD

a

SAS Programming 1: Essentials

SAS Programming 2: Data Manipulation Techniques

SAS Programming 3: Advanced Techniques and Efficiencies

SAS Macro Language 1: Essentials

SAS SQL 1: Essentials

SAS Enterprise Guide 1: Querying and Reporting

SAS Enterprise Guide: ANOVA, Regression, and Logistic Regression
Applied Analytics Using SAS Enterprise Miner

If you are a student, review the Academic Discounts site for promotional information or
ask your customer representative for details. Students are eligible to receive 50% off any
of the e-Courses that have been designed to work with SAS OnDemand for Academics
software.

To purchase any of the e-Learning courses mentioned, you can:

a

a
a

order online from SAS e-Learning
(http://support.sas.com/training/elearn/index.html)
call toll free at 1-800-333-7660

access the training registration form
(http://support.sas.com/training/us/regform.pdf)

Teaching materials

For a list of available teaching materials from SAS, visit SAS Global Academics Web site
at the following location: http:/support.sas.com/learn/ap/prof/index.html.

Enterprise Guide resources

The following training and reference materials for SAS OnDemand for Academics:
Enterprise Guide are available at no cost:

Tutorial

If you are new to SAS Enterprise Guide or want to learn more about using SAS
Enterprise Guide, you will find the free Getting Started tutorial helpful. As you
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complete the topics in this tutorial, you will learn to use the main features of SAS
Enterprise Guide.

After you have completed your registration and downloaded the software, you can access
this online tutorial by doing the following:

1 Select Start » Programs » SAS » Enterprise Guide 4.2 OnDemand. The
Credentials Required window opens.

2 Enter your SAS Server user ID. You can find this user ID on your SAS OnDemand
for Academics home page.

Enter the password associated with your SAS Profile account.

Select OK. The SAS Enterprise Guide window opens. You are now logged on to
the SAS Server.

5 Select Tutorial: Getting Started with SAS Enterprise Guide from the
Welcome to SAS Enterprise Guide window.

Online SAS Enterprise Guide Demonstration

To see SAS Enterprise Guide in action, visit the following Web site:
http://www.sas.com/govedu/edu/egdemo/itour_flash.html

Online Practice Exercises, Statistics Information, and Sample SAS
Data Sets

For instructions about how to perform all of the basic statistics taught in an
introductory statistics class, a library of SAS data sets and a library of practice
exercises, visit the SAS Online Resources for Statistics Education site at
http://support.sas.com/learn/statlibrary/.

Product Documentation

SAS Enterprise Guide online documentation is available from the Product
Documentation area on http://support.sas.com/documentation/.

Books

A number of books from SAS Publishing are available for SAS Enterprise Guide. You
can use the SAS Bookstore Web site (http:/support.sas.com/publishing/) to find the
books, review portions of each book, and place orders. You use the site’s search feature
to locate topics or products of interest such as for Enterprise Guide or Base SAS.

White Papers

You can access the following titles by visiting the locations provided below:
O A SAS Programmer’s Guide to SAS Enterprise Guide
http://supportexp.unx.sas.com/ondemand/pdf/SGF07_EG_for_Programmers.pdf
0 Dynamic Projects in SAS Enterprise Guide - How to Create and Use Parameters
http://supportexp.unx.sas.com/ondemand/pdf/SGF07_Parameters_in_EG.pdf

O Introduction to SAS Enterprise Guide 4.1 for Statistical Analysis
http://supportexp.unx.sas.com/ondemand/pdf/SUGI31_EGuide4-10verview.pdf
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Enterprise Miner resources

Product Documentation

To access product documentation, sample data, and more, go to SAS Enterprise Miner
from the Product Documentation area at http:/support.sas.com/documentation/.

Books

A number of books from SAS Publishing are available for SAS Enterprise Miner. You
can use the SAS Bookstore Web site (http:/support.sas.com/publishing/) to find the
books, review portions of each book, and place orders. You use the site’s search feature
to locate topics or products of interest such as for Enterprise Miner or data mining.

Forecast Server resources

Product Documentation

To access product documentation, sample data, and more, go to SAS Forecast Server on
the Product Documentation area at http:/support.sas.com/documentation/.

Books

A number of books from SAS Publishing are available for SAS Forecast Server. You can
use the SAS Bookstore Web site (http:/support.sas.com/publishing/) to find the books,
review portions of each book, and place orders. You use the site’s search feature to
locate topics or products of interest such as for Forecast Server or forecasting.
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SAS OnDemand for Academics with JMP Software

If you have purchased and installed JMP software (Version 8 or 9) in the United States,
then you can use JMP to connect to the hosted SAS servers that are used by SAS
OnDemand for Academics. This will enable you to integrate JMP and SAS together.
To integrate with SAS using this method, you must:

O register to use SAS OnDemand for Academics

O download sas.rutil.jar file and place it in the appropriate directory

O create a SAS server profile within JMP

O connect to the SAS server from JMP.

Step One: Registering to use SAS OnDemand for Academics

This step needs to be performed only once.

Instructor registration

If you are an instructor, perform the following steps:

1  Access SAS OnDemand for Academics.
http:/support.sas.com/ctx3/sodareg/index.html

2 Register as an instructor. During the registration process, a user ID and password
will be created for you.

3 After you have registered, log on to your SAS OnDemand for Academics home
page using your e-mail address and SAS profile password.

4 Create a course. When prompted to select a client, choose SAS Server Access for
JMP. During this process, the information that you need to create a SAS server
profile will be identified.

5 Invite your students to register for your course. Share the SAS server profile
information with them.
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Student registration

If you are a student, perform the following steps. Note that your instructor must have
registered a course before you can register.

1 Access SAS OnDemand for Academics.

2 Register as a student. Select the appropriate university and the course that is
associated with your instructor.

During the registration process, a user ID and password will be created for you.

Step Two: Downloading and installing the sas.rutil.jar file

For JMP to work properly with the SAS OnDemand for Academics hosted servers, you
must have the sas.rutil.jar file. This file is export controlled. It can only be used within
the United States by United States citizens or legal residents of the United States. The

file may not be shared with any party to whom the United States prohibits access to the
file.

1 Download the file from the Jar File Download Page at this location:
http://support.sas.com/demosdownloads/sysdep_t1.jsp?packageID=000747

2 Place the file in the appropriate location.

Q Ifyou are using a PC with the Microsoft Windows operating system, place the
jar file in the following location:

C:\Program Files\SAS\JMP\9\jmptojava\l9.2

(If your computer's hard drive is not labeled as 'C', then replace C with the
appropriate letter)

Q Ifyou are using a Macintosh PC, then do the following:
1 Navigate to the Applications folder.
2 Press Control and then click on JMP 8 or JMP 9.

3 Select Show Package Contents » Contents » Frameworks »
jmptojava P 9.2 » jars. Place the jar file in this location.

Step Three: Creating a SAS Server Profile within JMP

This step needs to be performed only once.
1 Start JMP.
2 Select File » SAS » Server Connections.

3 In the SAS Server Connections window, select 9.2 from the SAS Server Version
drop down field.

4 1In the SAS Server Connections window, click Metadata Server Profiles to open
the Manage Metadata Server Profiles window.

Click Add. Enter a profile name and description.

In the Machine field, enter sas92cloud.sas.com
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In the Port field, enter 18561

In the User name field, enter your SAS Server user ID. This user ID is also
displayed on your SAS OnDemand for Academics home page.

9 In the Password field, enter your SAS Profile password.
10 In the Authentication Domain field, enter DefaultAuth.
11 Click Save.

Step Four: Connecting to the SAS Server using JMP

This step should be performed any time that you want to connect to hosted SAS servers.
1 Start JMP.
2 Select File » SAS » Server Connections.

3 In the SAS Server Connections window, click Metadata Server Profiles to open
the Manage Metadata Server Profiles window.

4 Click the name of the profile that you created for the SAS server.
5 Click Connect.

Note: To disconnect from the SAS Server, return to the Manage Metadata Server
Profiles window and click Disconnect.
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